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Software License Agreement & Limited Warranty for Smart Control
IMPORTANT, READ CAREFULLY:
This Samsung End-User License Agreement (EULA) is a legal binding agreement between you (either an individual or an entity) and
Samsung for Samsung software product identified above, which includes computer software and may include printed material, and
“online” or electronic documentation (“SOFTWARE”). By installing, using the SOFTWARE, you indicate your acceptance of this
Samsung License Agreement. If you do not agree to the terms of this License Agreement, please do not install or use the enclosed
SOFTWARE.

SOFTWARE LICENSE
Copyright laws and international copyright treaties, as well as other intellectual property laws and treaties protect the enclosed SOFTWARE.

GRANT OF LICENSE. This License Agreement grants you following rights :
a. SOFTWARE; Samsung grants to you as an individual, a personal, non-exclusive license to make and use one (1) copy of the

SOFTWARE accompanying this Agreement on any single computer, provided the SOFTWARE is in use on only one computer at
any time. If you have multiple Licenses for the SOFTWARE, then at any time you may have as many copies of the SOFTWARE in
use as you have Licenses.

b. Electronic Documents; Solely with respect to electronic documents included with the SOFTWARE, you may make an unlimited
number of the copies, provided that such copies shall be used only for internal purpose and you shall not publish or distribute such to
any third party, without Samsung Electronics co., LTD. written and expressed consent.

c. Limitation on Reverse Engineering, Decompilation, Disassembly; You shall not reverse engineer, decompile or disassemble the
SOFTWARE, except to the extent that this restriction is expressly prohibited applicable law.

d. Separation of Components; The SOFTWARE is licensed as a single product. Its component parts may not be separated for use on
more than one computer.

e. Rental; you may not rent, lease and/or lend the licensed SOFTWARE.
f. Support Services; Samsung may provide you with support services related to the SOFTWARE, according to Samsung policies and

programs and in for the country in which the SOFTWARE was purchased. With respect to technical information you provide to
Samsung as part of the support services, Samsung may use such information for its business purpose, including for product support
and development. Samsung will not utilize such technical information in a form that personally identifies you.

g. SOFTWARE Transfer; You may permanently transfer all of your rights according to this agreement, provided you retain no copies,
you transfer all of the SOFTWARE, and the recipient agrees to the terms of this agreement by notifying in writing to authorized
Samsung VAR, outfit and/or dealer in which the SOFTWARE was purchased. And including all prior versions of SOFTWARE, if the
SOFTWARE is an upgrade.

h. Termination; Without prejudice to any other rights, Samsung may terminate this agreement if you fail to comply with the terms and
condition of this agreement. In such event, you must destroy all copies of the SOFTWARE and all of its component parts.

UPGRADES & COPYRIGHT.
a. Upgrade; If the SOFTWARE is an upgrade of a component of a package of software programs that you licensed as a single

product, the SOFTWARE may be used and transferred only as an part of that single product package and may not be separated
for use on more than one computer.

b. Copyright; The SOFTWARE is owned by Samsung or its suppliers and protected by copyright laws and international treaty
provisions. Therefore, you must treat the SOFWARE like any other copyrighted material except that you may install the
SOFTWARE on a single computer provided you keep the original solely for backup or archival purpose. You may not copy the
printed materials accompanying the SOFTWARE.
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LIMITED WARRANTY
LIMITED WARRANTY
Samsung warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying written materials for a period of ninety
(90) days from the date of receipt, and (b) any Samsung supplied hardware accompanying the SOFTWARE will be free from defects in materials
and workmanship under normal use and service for a period of one (1) year from the date of receipt. Any implied warranty on the SOFTWARE and
hardware are limited to 90 days and one year, respectively. Some countries, states, and/or jurisdictions do not allow limitation on duration of an
implied warranty, so the above limitation may not apply to you.

NO OTHER WARRANTIES
To the maximum extent permitted by the applicable law, Samsung disclaims all other warranties, either express or implied, including but not limited
to implied warranties of merchantability and fitness for particular purpose, with respect to the SOFTWARE, the accompanying product manual(s)
and written materials, and any accompanying hardware. This limited warranty gives you specific legal rights. You may have others rights, which
may vary from country/state/jurisdiction to country/state/jurisdiction depending in which one, you have purchased the SOFTWARE.

NO LIABILITY FOR CONSEQUENCY DAMAGES
Only to the maximum extent permitted by applicable law, in no event shall Samsung or its suppliers be liable for any other damages whatsoever
(including, without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising
out of the use of or inability to use the SOFTWARE product, even if Samsung has been advised of the possibility of such damages. Because some
states/jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages.

Si vous avez acquis votre produit Samsung Telecommunications America au CANADA, la garantie limitée suivante vous concerne:

GARANTIE LIMITEE
GARANTIE LIMITÉE - Samsung Telecommunications America garantit que (a) la performance du Logiciele sera substantiellement en conformité
avec la documentation qui accompagne le Logiciele, pour une période de quatre-vingt-dix (90) jours à compter de la date de réception; et (b) tout support
technique fourni par Samsung Telecommunications America sera substantiellement en conformité avec toute documentation afférente fournie par
Samsung Telecommunications America et que les membres du support technique de Samsung Telecommunications America feront des efforts
raisonnables pour résoudre toute difficulté technique découlant de l'utilisation du Logiciele. Certaines juridictions ne permettent pas de limiter dans le
temps l'application de la présente garantie. Aussi, la limite stipulée ci-haut pourrait ne pas s'appliquer dans votre cas. Dans la mesure permise par la loi,
toute garantie implicite portant sur le Logiciele, le cas échéant, est limitée à une période de quatre-vingt-dix (90) jours.
RECOURS DU CLIENT - La seule obligation de Samsung Telecommunications America et de ses fournisseurs et votre recours exclusif seront, au
choix de Samsung Telecommunications America, soit (a) le remboursement du prix payé, si applicable, ou (b) la réparation ou le remplacement du
Logiciele qui n'est pas conforme à la Garantie Limitée de Samsung Telecommunications America et qui est retourné à Samsung
Telecommunications America avec une copie de votre reçu. Cette Garantie Limitée est  nulle si le défaut du Logiciele est causé par un accident, un
traitement abusif ou une mauvaise application. Tout Logiciele de remplacement sera garanti pour le reste de la période de garantie initiale ou pour
trente (30) jours, selon la plus longue de ces périodes. A l'extérieur des Etats-Unis, aucun de ces recours non plus que le support technique offert
par Samsung Telecommunications America ne sont disponibles sans une preuve d'achat provenant d'une source authorisée.
AUCUNE AUTRE GARANTIE - Dans la mesure prevue par la loi, Samsung Telecommunications America et ses fournisseurs excluent toute
autre garantie ou condition, expresse ou implicite, y compris mais ne se limitant pas aux garanties ou conditions implicites du caractere adequat
pour la commercialisation ou un usage particulier en ce qui concerne le Logiciele ou concernant le titre, l'absence de contrefaaon audit Logiciele, et
toute documentation ecrite qui l'accompagne, ainsi que pour toute disposition concernant le suport technique ou la faaon dont celui-ci a ete rendu.
cette garantie limitee vous accorde des droits juridiques specifiques.
PAS DE RESPONSABILITE POUR LES DOMMAGES INDIRECTS - Samsung Telecommunications America ou ses fournisseurs ne seront pas
responsables en aucune circonstance pour tout dommage special, incident, indirect, ou consequent quel qu'il soit (y compris, sans limitation, les
dommages entraines par la perte de benefices, l'interruption des activites, la perte d'information ou toute autre perte pecuniaire) decoulant de
l'utilisation ou de l'impossibilite d'utilisation de ce Logiciele ainsi que pour toute disposition concernant le suport technique ou la faaon dont celui-
ci a ete rendu et ce, meme si Samsung Telecommunications America a ete avisee de la possibilite de tels dommages. La responsabilite de Samsung
Telecommunications America en vertu de toute disposition de cette convention ne pourra en aucun temps exceder le plus eleve entre i) le montant
effectivement paye par vous pour le Logiciele ou ii) us$5.00. Advenant que vous ayez contracte par entente distincte avec Samsung
Telecommunications America pour un support technique etendu, vous serez lie par les termes d' une telle entente.

La présente Convention est régie par les lois de la province d'Montreal,
Canada. Chacune des parties à la présente reconnaît irrévocablement la
compétence des tribunaux de la province d'Montreal et consent à instituer tout
litige qui pourrait découler de la présente auprès des tribunaux situés dans le
district judiciaire de Ontario, province d'Montreal.

Au cas où vous auriez des questions concernant cette licence ou que vous désiriez vous mettre en rapport avec Samsung Telecommunications
America pour quelque raison que ce soit, veuillez contacter la succursale Samsung Telecommunications America desservant votre pays, dont
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l'adresse est fournie dans ce produit, ou écrivez à: Samsung Telecommunications America Sales Information Center, 2700 NW 87th Avenue,
Miami, Florida 33172, USA.
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                                                                                        1
  

INTRODUCTION

 1.1 Smart Control Overview
Smart Control is a call manager application with support for contact management, scheduling and call
logging.  It also gives limited support for email and browsing.

 1.1.1 Station Setup Services
You can control your station parameters using these services. You can set/reset DND (Do Not Disturb), Call
Forwarding, Vacant Station Message, etc, using the simple user interface provided.

 1.1.2 Call Control Services
You can access all the basic and extended services of your Samsung DCS-VIP Key Telephone System
using Smart Control. You can make calls, answer call, release calls and  manage multiple calls at your
desktop. You can also establish multiparty audio conference through Smart Control without having to
remember any  PBX  feature codes. Some special features like speed dialling and continuous dialling are
supported.

 1.1.3 Directory Services
Smart Control allows you to maintain multiple phone books of your choice to keep track of your contacts.
You may also print all your contacts’ information in four different formats. Smart Control directories
provide Drag and Drop functionality for easy call control. You can import your existing database from your
current Personal Information Manager (PIM) application—ACT! 2.0 or ACT! 4.0 for Windows, PS2000 or
Microsoft OutLook—into Smart Control. The Directory Services feature also allows Smart Control to
identify the caller if the contact information is available in Smart Control or other applications using a
Dynamic Data Exchange (DDE) mechanism.
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 1.1.4 Scheduler Services
Smart Control allows you to schedule a telephone call or activation of some of the station setup options for
execution at some later point of time. A note that will show at the time of execution may be entered to
explain why this call or feature was scheduled. A pop-up window gives you the option to cancel any
scheduled item at the scheduled time of execution or to change the time of execution.

 1.1.5 Call Log Services
Smart Control’s Call Log maintains a record of all incoming and outgoing calls from the keyset while the
application is active. Call log records contain a Notes field for recording information about a particular call
and a Keyword field to enable the logs to be searched. Smart Control allows you to print individual Call
Log records, selected Call Log records or an entire Call Log. This will allow you to archive hard copies of
the logs for later perusal.
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                                                                                                                                                         2

SMART CONTROL INSTALLATION

 2.1 System Requirements
To install Smart Control, you need the following minimum system specification:

* 80486 CPU
* MS-Windows 95/98/NT Server or Workstation 4.0  or later, Windows 2000 Series
* 8 MB main memory
* 16 MB free hard disk space

 2.1.1 Connection Configuration

FIGURE 2-1
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1) Using DCS-VIP MMC 823, set the CTI Link Type.
- CTI IP ADDRESS : Enter your DCS-VIP System Router IP Address.
- CTI USING PORT : Enter  the Port Number(Default Value : 5000)
- SELECT DRIVER : Select “Standalone” Mode

   
2) Using DCS-VIP MMC824, Enter each IP Address of the Computer System that

Smart Control is installed on and the telephone number.

- CLT XX  [ ENA / DIS ]  [ 201 / 301 / … ]  XXX.XXX.XXX.XXX
. XX : Select one between 01 ~ 20
. ENA / DIS : Select “Enable” to use this phone number
. 201 / 301 / … :  Select the telephone number you want to use.
                                 (Telephone Number Sharing is impossible)

       . XXX.XXX.XXX.XXX : Enter IP Address of your PC that smart control vip
version will be installed

For more information, contact your DCS-VIP System Manager.
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 2.2 How to Install

 2.2.1 Installing on Windows 95/98/NT Series
* Start Windows
* Insert CDROM and then Setup Program will be run automatically.
* If not, Run Setup.exe on the Install CD(where E: is the CDROM drive)

Follow the instructions in the Setup program. These instructions are described below.

1. Click the Next button in the Welcome dialogue box to continue Setup or the Cancel button to exit
Setup.

FIGURE 2-2

Note for Windows 95 Users: If you do not have Microsoft TAPI 2.1 installed on your system, you
will be given the option to install TAPI 2.1 before installing Smart Control.  Select Yes to install TAPI
2.1 and proceed with Smart Control installation. If you select No, Smart Control Installation will be
aborted.

FIGURE 2-3
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2. Read carefully the Software License Agreement (Figure 2-4).

FIGURE 2-4

3. Enter name and company name in the dialogue box (Figure 2-5).

4. Enter serial number (S/N). The S/N is printed on the product package box.

FIGURE 2-5
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5. Click Next button to continue.

6. Choose the destination directory where Smart Control will be installed.

FIGURE 2-6

7. Select the components you want to install. By default, All Components are selected(Recommended)
When you want to install only one component (Smart Control for DCS-VIP Application or Samsung
TAPI Service Provider for DCS-VIP), check that component and uncheck other.

FIGURE 2-7
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8. The following dialogue box appears. Click Next after entering the program folder name.

FIGURE 2-8

9. Files are copied to your selected directory and the ODBC is configured. The following dialogue box
appears. Click Next button.

FIGURE 2-9
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10. The following Call Notification Options dialogue box appears. Enter your options. While using Smart
Control you can change the call notification options by selecting the Call Notification… item on the
Option menu.

FIGURE 2-10

11. The following dialogue boxes (Figures 2-11 and 2-12) appear if you selected to install the
DCS Service Provider component in step 7.  Select the DCS model you are using: users in
the United States should select STA Model; other users should select Other.

FIGURE 2-11
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12. Enter the DCS Service Provider information in the next dialogue box. Enter your DCS-VIP System IP
Address and Port Number in the IP Address and Port No Field.(Refer to 2.1.1. Connection
Configuration Section) The name entered in the Line Name field appears at the Status position of the
Smart Control window (see Section 3). Phone Number Field will be automatically detected when the
CTI Link is initialized. (when the detected number is different from your entered number, the detected
number will be used.)

FIGURE 2-12

13. Change the dialling properties, if needed. The dialogue box below shows the properties.

FIGURE 2-13
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14. When you click the OK button on the above dialogue box, the next dialogue box appears confirming
that Smart Control has been installed successfully.

FIGURE 2-14

15. Click Finish button to complete the Setup.
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 2.3 Troubleshooting
If you have problems running Smart Control, look through the problem checklist below.
 

Symptom or Error Message Resolution

Out of Services

* Check software setup, specially IP Address and Port No
selection

* Check if the system’s Network Confuguration is connected
(Your Computer and VIP Side)

* Check DCS-VIP CTI Link Confuguration (using MMC 823)
* Check DCS-VIP CLT Configuration (using MMC 824)

Unable to make Outgoing Calls

* Check your telephony dialing parameters from the Control Panel
* Check whether any call already existed on your station before

you started Smart Control. If so, start Smart Control again when
there are no calls at your station.

TABLE 2-1
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                                                                                3

WHAT WILL YOU SEE WHEN YOU START SMART
CONTROL?

When you start Smart Control, the main screen is displayed.

FIGURE 3-1

Line
Status

General
Tool Bar

Station
Control Bar

Selection
View

Detailed
View

Call Control
View

Status
Bar
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The table below describes the items shown in Figure 3-1:

Item Purpose

Line Status Shows the status of your application i.e. either Out of Services or your
Telephone Extension or any Vacant Station message left by you

Menu Bar Shows the different menu options categorized by the services provided

Tool Bar

There are two Tool Bars in Smart Control, a fixed General Tool Bar and a
dockable Station Control Tool Bar. You can choose from any of the three sizes
of the Station Control Tool Bar.

Using the General Tool Bar you can perform Services (i.e. Directory, Call Log
& Scheduler) based operations.

Using Station Control Tool Bar you can perform station features related
operations like DND, Call Forward etc.

Selection View

Selection View is used to access various Smart Control services. You can
access these services in two ways:

1. Tree view – Default view
2. Icon view

Detailed List View

You can view the detailed contents of all the Smart Control services. The
Personal PhoneBook is selected by default. In Detailed List View, Directory
Services displays the contents of all the contacts. Its contents are as follows:

* Name
* Company
* Office phone
* Office phone extension
* Home phone
* Mobile
* Pager number
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Item Purpose

Detailed List View

Scheduler Services displays the contents of all the scheduled item. Its contents
are as follows:

* Function
* Details
* Frequency
* Time
* State of Schedule
* Note

Detailed List View

Call Log Services displays the contents of all the logged calls. Its contents are
as follows:

* Name
* From/To
* Date
* Duration
* Status
* Identifier
* Call Note

Call Control View You can perform call control options like dialing, transferring a call,
conferencing, etc.

Status Bar

You can see the current status of your telephone such as DND, Call Forward,
Msg List (list of stations that left messages), Call Back (station on which Call
Back is set.), and whether your station is currently locked. You can also see the
current time on the Status Bar.

TABLE 3-1



Smart Control User Guide 26

 3.1 Tool Bar
There are two Tool Bars in Smart Control,

* General Tool Bar
* Station Control Tool Bar

 3.1.1 General Tool Bar

The General Tool Bar, depending upon the services currently selected (i.e. Directory or Scheduler or Call
Log), helps you to perform operations related to these services.
 
 

 
 
The function of each Tool Bar button with respect to the context of the currently selected services is as
follows:

3.1.1.1 General Tool Bar for Directory Services

If Directory Services is currently selected then you can perform the following operations using the
General Tool Bar.

 

 
Add Contact button – To add new contact record to your current book.

 
Update Contact button – To update the currently selected contact record in the current
book.

 
Delete Contact button – To delete the currently selected contact record in the current book.
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Delete All button  - To delete all contact records of current book.

 
Search button – To search for text entered by a user in the contact records of the current
book.

 
Print button – To print the contact records information of the current book.

TABLE 3-2

3.1.1.2 General Tool Bar for Scheduler Services

If Scheduler Services is currently selected, you can perform the following operations using the General
Tool Bar.

 

 
Schedule button – To add a new schedule to the schedule list.

 
Update Schedule button – To update the currently selected schedule in the schedule list.

 
Delete button – To delete the currently selected schedule in the schedule list.

 
Delete All button  – To delete all schedules present in the list.

 
Search button – Disabled.

 
Print button – Disabled.

TABLE 3-3
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3.1.1.3 General Tool Bar for Call Log Services

If Call Log Services is currently selected, you can perform the following operations using the General
Tool Bar.

 

 
Add button – Disabled.

 
Update button – Disabled.

 
Delete button – To delete the currently selected log record in Call Log.

 
Delete All button – To delete all logged records from the Call Log.

 
Search button – To search Keyword in all Call Log records.

 
Print button –  To print the Call Log records.

TABLE 3-4

 3.1.2 Station Control Tool Bar

The Station Control Tool Bar helps you to set station features such as DND, Call Forward etc. It is a
dockable toolbar with three different sizes: small, large and large with text (see below). You can select any
one of these sizes from the View/Tool Bar menu.
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Small

 

Large

 

Large With Text

 

The following table explains the operations that can be performed using buttons of any of these Tool Bars.
 

 
DND button – To Set/Reset DND.

 
Call Forward button – To Set/Clear Forwarding types.

 
VSMsg button – To Set/Clear Vacant Station Message.

 
Auto Answer button - To set auto answer options for different call types.

 
Call Back button – To set a call back on currently dialed busy or non-answering station.

 
Leave Message button – To leave a message on currently dialed non-answering station.

 
Message List button – To view a list of messages set on your station by other station.

TABLE 3-5
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 3.2 Status Bar
 
The Status Bar shows the status of your station such as DND(Do Not Disturb), Locked, Msg List(list of
stations that left messages), etc. if you set your station parameters with various features supported by your
DCS Keyset . The illustration below shows the Status Bar as you might see it.
 

 
 
The highlighted panes indicate that the corresponding features are set. You can change the colors of the
panes (see “How Do You Change Color of Status Bar Panes?” in Section 4).
 

Status Description

AutoAns Indicates AutoAnswer set for any call types like Internal, External, Hold Recall
etc.

Locked When the station is Locked.

CallBack If your station has set a call back on some other station.

Msg.List If some other station has set a message for you.

Call Forwarding
Type If you have set Call Forwarding or any other station has set Follow me.

DND If you have set your station to Do Not Disturb mode.

TABLE 3-6

* Set/reset of station feature made easy

You can set/reset the above station features by double clicking in the corresponding pane.The first pane is
the Ready pane for showing prompt messages. The last pane shows the current system time.
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 3.3 Views of Smart Control

 3.3.1 Tree View
If you select the Tree view from View option, the Selection View will display the services in the tree
structure shown below.

FIGURE 3-2

 3.3.2 Icon View
If you select the Icon view from View option, the Selection View will display the services in the icon
structure shown below.

  
FIGURE 3-3
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 3.3.3 Hidden View
If you select the Hide View option, the Smart Control Selection View will be hidden and only the Detailed
List View will be shown. Click Show View, if you want Selection View in view. You can also click the
right mouse button to get Hide option.

FIGURE 3-4
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                                                                                4

SMART CONTROL CONFIGURATION

You can set various options provided in the Smart Control software using the submenus under the Option
menu.

Option Purpose

Call Notification Method To notify you about caller detail

Set Environment ! Speed Dial Numbers… To set speed dial numbers.

Set Environment ! Fast Pick Up Numbers… To set fast pick up numbers

Set Environment ! Page Zone Name… To set page zone names

Set Environment ! Status Bar Color… To change the color of the Status Bar panes.

Set Environment ! Time Out… To set the time out time for various services

Set Environment ! DDE… To enable/disable DDE & configure DDE Server
applications.

TABLE 4-1
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 4.1 How Do You Set Up Call Notification?

Click on the Options menu and select the Call Notification Method. A Call Notification dialogue box
appears, in which you can select the options.

FIGURE 4-1



35

 4.1.1 How Do You Display Incoming Call Details?

4.1.1.1 For External Calls

Select the For Incoming External Call option, if you want to identify the external caller. A dialogue box,
or property sheet, will appear (Figure 4-2), with which you can identify the caller if the caller’s number is
available in the Directory database.

4.1.1.2 For Internal Calls

Select the For Incoming Internal Call option, if you want to identify the internal caller. A dialogue box, or
Property sheet, will appear (Figure 4-2), with which you can identify the caller if the caller’s number is
available in the Directory database.

 
FIGURE 4-2

 

 
Note: If there are more than one contact in the Directory database, which matches the incoming
phone number, then, the first contact which matches will be shown.
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 4.1.2 How Do You Get Details for Outgoing Internal Calls?
Select the For Outgoing Calls option, if you want to identify the outgoing called number. A dialogue box
will appear with which you can identify the number, if the given number data is available in the Directory
database.

 4.1.3 How Do You Bring Smart Control to the Front for an Incoming Call?
Select the Bring Smart Control to Front option, if you want Smart Control to be maximized automatically
on an incoming call, while it is running in the minimized mode. The application also comes to the front if
it’s in the background. If this option is not selected, for an incoming call the minimized Smart Control
window flashes.

 4.1.4 How Do You Play a Sound File for an Incoming Call?
Clicking on the Play Sound for Incoming Call option, if a call comes in, causes a sound file to be played
through the multimedia card on the PC. You can select the *.wav file by clicking the Browse button and
selecting the wave file from the Open dialogue box. You can test the wave file that you have selected by
clicking the Test button.
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 4.2 How Do You Configure Speed Dial Numbers?
Click on Option menu and select Set Environment ! Speed Dial Number option. An Edit Speed Dial
dialogue box will appear, in which you have five default buttons. You can select the speed dial button you
want to program by clicking on the button. This will allow you to enter the telephone number and button
name in the fields at the bottom of the window.

FIGURE 4-3

Once you have entered the name of the contact in the Name field and the number in Number to dial field,
click on the OK button. These speed dial numbers would be available in the Dial pad, Transfer pad and
Conference pad for one-touch dialling, transferring and conferencing respectively.

If you wish to configure more than one number, just click on the next button you want to program after you
have finished entering data for the current button. You can also edit the speed dial name and number by
clicking on any button and editing it in the respective fields.
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 4.3 How Do You Set Fast Pick Up Numbers?
Select the Set Environment ! Fast Pick Up Numbers option from the Option menu to set fast pick up
numbers in the Fast Pickup Edit dialogue box.

FIGURE 4-4

Once you have entered the name of the contact in the Name field and the number in Number to dial field,
click on the OK button.
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 4.4 How Do You Set Page Zone Name?
Select the Set Environment ! Page Zone Name option from the Option menu to set Page Zone Name in the
Page Zone Names dialogue box.

FIGURE 4-5

Select the zone you want to set and click on OK.
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 4.5 How Do You Change Color of Status Bar Panes?
To change the Status Bar pane colors, select Set Environment ! Status Bar Color… option from the Option
menu. A Change Pane Text Color dialogue box appears. The colored buttons show the pane text colors
presently selected for the Status Bar panes. Click the button corresponding to the station feature pane whose
color you want to change. Select the color from the Colors dialogue box.

FIGURE 4-6
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 4.6 How Do You Set the Time Out Parameters?
Click on the Options menu and choose the Set Environment ! Time Out option. A Time Out dialogue box
will appear. Set the Time Out against the options available. You can set the time out, in seconds, for the
Auto Answer, Clear Call and Dial Duration (retry) intervals.

FIGURE 4-7

 

Option Purpose

Auto Answer Sets the time for the Smart Control to answer automatically

Clear Call Sets the time to clear the disconnected call from the Call Control View

Dial Duration Sets the time to retry, if you want to dial continuously

TABLE 4-2

 4.6.1 How Do You Set Time Out for Auto Answer?
The timer value entered in this field determines the delay before the program will automatically answer a
call if that type of call has been flagged for Auto Answer. You can enter the time out value in the
AutoAnswer field of the Time Out dialogue as shown above.
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 4.6.2 How Do You Set Time Out for Clear Call?
The timer value entered in this field determines the length of time the Call Control window will remain open,
allowing notes to be made or a keyword to be entered after the call has been disconnected. You can enter
the time out value in the Clear Call field of the Time Out dialogue as shown above.

 4.6.3 How Do You Set Dial Duration for Continuous Dialling?
The timer value entered in this field determines the length of time the application will wait before redialling
when the Continuous Dial feature has been activated. You can enter the retry value in the Dial Duration
field of the Time Out dialogue as shown above.

 4.7 How Do You Change DDE Options?
To change DDE(Dynamic Data Exchange) related options, select Set Environment ! DDE... option from
the Option menu.

Check the “Enable DDE for Incoming Calls” check box if you want DDE for incoming calls. You can
specify the call type, i.e. enable DDE for internal incoming calls or external incoming calls or both. You can
also specify whether the contact search should be based on Caller ID or DNIS(Dialled Number
Identification Services).

Select the database application, such as Symantec ACT! 2.0, GoldMine4.0 etc, of your choice. Enter the
selected application’s EXE file path in the program’s “Path” box. You can even browse to find the EXE file
using the Browse button.

Enter the database file in the database’s “Path” box. This is the file that contains your contact records. The
Test button helps you to check whether you have entered the selected application’s EXE file path properly.
See “DDE Support in Smart Control” (Section 11) for more information.
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5

STATION SETUP
 
 
 
You can set your station parameters with various features supported by your DCS Keyset. This menu has
the following options.
 

Item Purpose

Station Lock/Unlock Locks/Unlocks the station from making or receiving any call

Do Not Disturb Sets/Resets your station to Do Not Disturb mode

Call Forward Forwards calls from your station to another station

Follow Me Redirects calls from other station to your station

Message List Displays the list of messages left by other station on your station

Call Back Status Displays the station number or trunk number on which you have set a call
back.

Vacant Station Message Sets an absent station message e.g. “In a Meeting”

In Out of Group Allows you to get In/Out of a group to which you belong

Auto Answer To auto answer after the set time out

Auto Trunk Call Back To set trunk call back automatically when trunk is busy

TABLE 5-1
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 5.1 How Do You Set a Station Lock / Unlock?

 5.1.1 How Do You Set a Station Lock?
You can lock your station using the Station Lock option. This prevents other people from making calls from
your station, in your absence. It also prevents you from receiving incoming calls.

FIGURE 5-1

Once you click on the Station Lock option, a Station Lock dialogue box will appear. Enter your password
and click OK to lock your station. You can also double click in the Locked pane of the Status Bar to change
Station Lock/Unlock.

 5.1.2 How Do You Unlock Your Station?
To unlock your station, click Station Unlock option in the Station Setup menu and enter the password or
double click in the Locked pane of the Status Bar to enter the password in the dialogue box.
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 5.2 How Do You Set Your Station to Do Not Disturb Mode?
If you do not want to be disturbed with incoming calls you can set your station to Do Not Disturb (DND)
mode.

 5.2.1 How Do You Set/Reset DND on Your Station from Station Setup Menu?
Click on Station Setup menu and select DND option. If there is an incoming call when you have set your
station to DND mode, the caller will get a DND message. To reset your station from DND mode, select the
DND option from the Station Setup menu again.

 5.2.2 How Do You Set/Reset DND on Your Station from Status Bar?
You have the easy option of double clicking in the DND pane of the Status Bar to Set /Reset DND.

 5.2.3 How Do You Set/Reset DND Using Hot Key?
Press F8 function key to set your station to DND mode. To reset your station back to normal mode press F8
function key again.

 5.2.4 How Do You Set/Reset DND from the Tool Bar?
 

 

Click on the Do Not Disturb button on the Station Control Tool Bar to set your station to DND mode. To
reset from DND mode, press this button again. If DND is set for your station, the Status Bar will display this.
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 5.3 How Do You Set Call Forwarding?
You can forward internal and external calls to another station. You can also forward your calls from an
external party to an external telephone number.

 5.3.1 How Do You Set Call Forwarding from the Station Setup Menu?
Click on Station Setup menu and select Call Forward option. The Call Forward dialogue box will appear
(Figure 5-2).

 5.3.2 How Do You Set Call Forwarding from Status Bar?
You have the easy option of double clicking in the Forward pane of the Status Bar to get the Call Forward
dialogue box.
 

 
FIGURE 5-2
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Option Purpose

All Calls Forward all Incoming calls

On Busy Forward Incoming calls to another station, if your station is busy

On No Answer Forward Incoming calls to another station, if you do not answer.

On Busy / No Answer Not Supported

External Calls Forward your external calls to an external number

DND Forward Forward incoming calls to another station, if your station is set to DND
mode (this option may not be selectable on your system)

TABLE 5-2

 
Enter the Forward Type of call you want to forward. Enter the number of the other station in Forward To
field and click on Set button to enable the Call Forward. You can also select the station from the Call
Forward selection list to choose any of the previously entered numbers.

 5.3.3 How Do You Set Call Forwarding from the Tool Bar?

 

Click on the Call Forward Tool Bar button to get the Call Forward dialogue box. Select the type of call you
want to forward and enter the number in the selection list. Click on Set button.

 5.3.4 How Do You Reset Call Forwarding?
 
Click on Station Setup menu and select Call Forward option. The Call Forward dialogue box will appear.
Click on the Clear button to clear all types of call forwarding at your station.
 
Click on the Call Forward Tool Bar button to get the Call Forward dialogue box. Click on the Clear button
to clear all types of call forwarding at your station. If forwarding is set for any type of call, the Status Bar of
your station will display this. You can also double click on this highlighted pane of your Status Bar to get
the Call Forward dialogue box.
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 5.4 How Do You Redirect Calls to Follow You?

You can redirect your calls from another station to your current station. Click on Station Setup menu and
select Follow Me option. This will display the Follow Me dialogue box. Enter station number from which
all the calls will be forwarded to you. If there is an incoming call at that station, the call will be redirected to
your station.

FIGURE 5-3
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 5.5 How Do You Check Your Station’s Message List?
Click on the Station Setup menu and select the Message List option to check whether any other station has
left a message for you when your station was busy or when you did not answer. The message list will
contain the station number which has left the message for you. Station Setup menu’s Message List option
will be disabled if no station has left a message for you.

You can select the station and call the station back by clicking the Call button. You can clear the selected
message by clicking the Clear button or clear all the messages by selecting the Clear All button. The Status
Bar will show Msg List if another station has left a message on your station. Double click in the highlighted
pane of the Status Bar to get the Waiting Messages dialogue box. You can also use the Station Control Tool
Bar’s Message List button to get the dialogue box.

FIGURE 5-4
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 5.6 How Do You Check Your Station’s Call Back Status?
Click on the Station Setup menu and select the Call Back Status… option to check whether you have left a
call back message on any other station. This option will be enabled only if you have set a Call Back on
some other station. A Call Back dialogue box will appear showing the station number.

Press Clear button if you wish to clear the Call Back to this station.

FIGURE 5-5

The Status Bar will show CallBack, if you have set call back on some other station. Double click in this
highlighted pane to get the above dialogue box. If you have set call back on more than one station  you can
clear them one by one if needed.
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 5.7 How Do You Set a Vacant Station Message?
 
You can leave a Vacant Station Message for your station in case you are not available to take your calls.

 5.7.1 How Do You Set a Vacant Station Message from Station Setup Menu?
To set a Vacant Station Message, click on Station Setup menu and select Vacant Station Message option.

The Vacant Station Message dialogue box will appear. Check the Enable Station Message checkbox and
select the message from the pull-down menu. Click OK.

FIGURE 5-6

 5.7.2 How Do You Set a Vacant Station Message from the Tool Bar?

 
Click on the Vacant Station Message button on the Station Control Tool Bar and set the type of message in
the Vacant Station Message dialogue box. The Smart Control title bar (top of screen) will show the type of
Vacant Station Message you have left for your station, e.g In a Meeting.
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 5.7.3 How Do You Clear a Vacant Station Message?
To clear a Vacant Station Message, click on Station Setup menu and select Vacant Station Message option
or click on the Vacant Station Message button on the Tool Bar.

The Vacant Station Message dialogue box will appear. Remove the selection for Enable Station Message
checkbox and click OK button. The Vacant Station Message is cleared.

 5.8 How Do You Check Whether You are In or Out of a Group?
Click on Station Setup menuand select In Out of Group… option. An In Out Group dialogue box will
appear, in which you can check on group numbers you want to enter or leave and then click OK.

FIGURE 5-7

Note1: Group numbers appears in the group list shown above, only if your station is a group
member.

Note2: If you belong to multiple groups and not all of them are checked in In Out Group dialog
box, your keyset displays such a message, “You can't recieve group calls”. It means you can't
receive all group calls you belong. Of course, you can recieve checked group calls. It displays
“You can recieve group calls” only if you check all the groups.
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 5.9 How Do You Set Smart Control to Auto Answer?
Click on the Station Setup menu and choose the Auto Answer option. You can select the type of call you
want the station to auto answer from Call Types in the Auto Answer dialogue box.
 

 
FIGURE 5-8

 
If any of the Call Types options is selected, Smart Control will automatically answer that type of call after
the time which is set in the Time Out option. You have the option of double clicking in the AutoAns pane of
the Status Bar to change Auto Answer options.

 5.10 How Do You Set Auto Trunk Call Back?
To set trunk call back automatically, select the Auto Trunk Call Back option from the Station Setup menu.
To deselect the option click on the Auto Trunk Call Back option again. Note that Auto Trunk Call Back
doesn’t work during conference call and transfer call.
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6

CALL CONTROL SERVICES

This chapter tells you about the Call Control Services. The bottom half of the menu screen is called the Call
Control View. The Call Control View is used to access call control related services.

FIGURE 6-1

The call view has buttons for various call control functions and a call list to display the calls at the station.

" Call List

Header Purpose

Number
For external calls, shows the caller id, if available; else it shows the trunk number
and the DNIS(Dialled Number Identification Services), also if available. For
internal calls, shows the station number.

Name Shows the name of the connected party.

Status Shows the status: incoming call, On Hold, On Hold pending transfer, On Hold
pending Conference etc.
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Duration Shows the connected duration of the call

Reason Shows whether the call is a Recall, Call Back, etc.

TABLE 6-1

 

" Call Control View Buttons

Buttons Purpose

To make a call

To answer a call or unhold a call

To release an active call

To hold an active call

To transfer an active call

To conference

To Toggle between calls

To Redial the last number

To Continuously dial the last number

To pick up a call

To Page

TABLE 6-2
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" Call Control Menu

Options Purpose

Dial To make an Outgoing call or to dial on the current call

Answer To answer an incoming call or retrieve a held call

Release To release an active call

Redial To redial the last dialed number

Hold To hold an active call

Transfer To transfer a call to another station

Conference To conference

Make New External
Call To make an Outgoing new external call

Continuous Dialing To continuously dial the last dialed number

Pick Up To pick up a call from another station/group

Pickup U/A Device To pickup the call from a Universal Answerable  device

Toggle To toggle between two calls

Hook Flash To hook flash to an external number

Page To page a zone

Send DTMF To send DTMF Tones

Call Back To set the busy/no answer station to call back

Leave Message To leave a message for a busy station or a station which does not
answer

Camp On To indicate a busy station that your call is waiting

OHVA To intrude into a busy station

TABLE 6-3
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 6.1 How Do You Make a Call?

 6.1.1 How Do You Make a Call from the Call Control Menu?
Click on the Dial option and the Dial dialogue box will appear.
 

 
FIGURE 6-2

 
Click on the numbers in the dial pad and click on the Send button to make a call. You can click on the pull-
down menu to select and dial any of the last 10 numbers you have dialled previously.

You can also click on any of the Speed Dial buttons for quicker access.

 6.1.2 How Do You Make a Call Using Hot Key?
You can press the F2 function key to get the Dial dialogue box to make a call.

 6.1.3 How Do You Make a Call from Call Control View?
 

 
Click on the Dial icon in the Call Control View to get the Dial dialogue box to make a call.
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 6.1.4 Other Ways of Making a Call

 6.1.4.1 How do you make a call using Drag and Drop?

Select the contact to whom you want to make a call in the Detailed List View, when in Directory Services.
Drag and drop the contact into the Call Control View to make the call. Office phone is the default number
dialled. If you drag from the home, mobile or the pager column, the respective phone numbers will be
dialled.

 6.1.4.2 How do you make call from the property sheet?

Double click on any contact in the Detailed List View to be dialed. Select Contact Info from the Update

Record dialog box. Click on this  icon to dial the number against it.

 6.1.4.3 How do you make a call using the right click menu?

Select the contact to whom you want to dial in the Detailed List View and click the right mouse button. A
pop-up menu will appear. Select the Dial option to dial the contact’s office number.

 6.2 How Do You Answer a Call?
When there is an incoming call, the status of the call is shown in the Call Control View. If there is more than
one call in the call list, you can select the call to answer.
  
When an incoming call is received from a station, Smart Control will display the station number and the
name of the station, if it is set, and the type of the call if it is not a direct call.

FIGURE 6-3
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When an external incoming call is received by Smart Control, it displays:

1. The trunk number, if the caller id is not available.

FIGURE 6-4

2. The caller id, if it is available.

FIGURE 6-5

3. The caller id and called id (DNIS), if they are available.

FIGURE 6-6
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 6.2.1 How Do You Answer a Call from the Call Control Menu?
Click on the Call Control menu and select the Answer option to answer a call.
 

 6.2.2 How Do You Answer a Call Using Hot Key?
Press F3 function key to answer a call.

 6.2.3 How Do You Answer a Call from Call Control View?
 

 
Click on the Answer button in the Call Control View to connect the call. The Call Control View will display
the details of the active connected call.

FIGURE 6-7
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 6.2.4 Other Ways You Can Answer a Call

6.2.4.1 How do you answer a call using double mouse click?

Select the incoming call in the call list. Double click on the call to answer.

6.2.4.2 How do you answer a call using the right click menu?

If there is more than one call in the call list, select the call to answer and click the right mouse button to
get the menu. Choose the Answer option to answer the call.

 6.3 How Do You Release a Call?

 6.3.1 How Do You Release an Active Call from the Call Control Menu?
Click on the Call Control menu and select the Release option to disconnect an active call.

 6.3.2 How Do You Release an Active Call Using Hot Key?
Press F4 function key to disconnect an active call.

 6.3.3 How Do You Release an Active Call from the Call Control View?
 

 
 
Click on the Release button in the Call Control View to disconnect an active call.

 6.4 How Do You Redial the Last Number Dialled?
You can dial the last dialled number again.

 6.4.1 How Do You Redial from the Call Control Menu?
Select the Redial option from the Call Control menu to dial the last number dialled.
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 6.5 How Do You Hold/Retrieve a Call?
You can hold your active calls and retrieve them from the call list in the following ways.

 6.5.1 How Do You Hold/Retrieve Calls from the Call Control Menu?
To hold a call, click on the Hold option in the Call Control menu when there is an active call. The held call
will be displayed in the call list.

FIGURE 6-8

You can retrieve this call by selecting the held call in the call list and clicking on the Answer option in the
Call Control menu.

 6.5.2 How Do You Hold/Retrieve Call Using the Hot Key?
Press F5 function key to hold a call. To retrieve this call, press F3 function key.

 6.5.3 How Do You Hold/Retrieve a Call from the Call Control View?
 

 
 
Click on the Hold button in the Call Control View to send the active call to OnHold state in the call list.  To
retrieve this call, select the call from the call list and click on the Answer button in Call Control View.
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 6.5.4 Other Ways to Retrieve a Call

6.5.4.1 Using the right mouse button in the call list

Click the right mouse button on the held call in the call list and select the Answer option to retrieve the
held call.

6.5.4.2 Using double click in the call list

Double click on the held call in the call list to retrieve a call.

 6.6 How Do You Transfer a Call?
You can transfer your active calls to other stations.

 6.6.1 How Do You Transfer a Call from the Call Control Menu?
Click on the Transfer option in the Call Control menu. You will get the Transfer Call dialogue box. Enter
the number in the pull-down menu to which the call is to be transferred.

FIGURE 6-9

Note:  When a call is put in hold state, it will go to the Call List and shows that it is ON HOLD.
If you do not retrieve this call, within the set time, it will come back with the reason as HOLD
RECALL.  This is to avoid anyone waiting continuously for you to answer
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You can also choose the last 10 numbers from the pull-down menu or click on any of the Speed Dial buttons.

You can transfer your calls in two ways:

Blind Transfer button

Consultation Transfer button

TABLE 6-4

6.6.1.1 How do you Consult and Transfer a Call?

After you enter the number to which the call is to be transferred, click on the Consultation Transfer button.
The active call goes into OnHold pending transfer mode, while you consult with the station as to whether
the station agrees to take the call. Click on the Release button to transfer the call.

6.6.1.2 How do you blind transfer a call?

After you enter the number to which the call is to be transferred, click on the Blind Transfer icon. The
active call will get transferred to the station as soon as the transferred party’s phone rings. You cannot
blind transfer a call to an external number.

 
 
 
 

Note: Blind Transfer is not supported for external calls. In case you choose Blind Transfer for
an external call, Consultation Transfer will be performed.
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 6.6.2 How Do You Transfer a Call from Call Control View?
 

 
 
Click the Transfer button in the Call Control View to transfer a call.

 6.6.3 How Do You Transfer a Call Using the Hot Key?
Press F6 function key to transfer an active call.

 6.6.4 Other Ways of Transferring a Call

6.6.4.1 How do you transfer a call using Drag and Drop?

Select the contact to which you want to transfer from the Detailed List View. Drag that number holding
the CTRL key and drop into the Call Control View.

6.6.4.2 How do you transfer a call using the right click menu?

Click on the selected contact in the Detailed List View and right click to get a pop up menu.

Select the Transfer option to transfer a call.
 
 
 

Note: If the Transferred Party is not in his/her place or does not answer, the call comes back
after a few rings with a call reason as Transfer Recall.  This is because the originally calling
party is waiting for the answer.
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 6.7 How Do You Conference?
If there is an active call in the Call Control View, you can have another call join you in a conference in the
following ways.

 6.7.1 Conferencing from Call Control Menu
Click on the Call Control menu and select the Conference option, when there is an active connected call. A
Conference With dialogue box will appear.

FIGURE 6-10

 
The Call Control View will change as shown.

FIGURE 6-11
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When the other party answers, click on Call Control menu and select Conference option again. If the other
party does not answer, you can release this call and get connected to the original party using the Release
menu/button.
 
If you want to add another party to the conference, click on the Conference option to get the Add To
Conference dialogue box.

FIGURE 6-12

Enter the number and dial. Once you are connected to the party, press the Conference button to include the
party into conference.

The status of the calls in the call list which are already in conference goes into OnHold(Conf) till the party is
included in the conference. You can add a maximum of five parties to the conference.

FIGURE 6-13
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When the other party answers, select Conference option again to add this party to conference. The status in
the call list displays conference. If the party does not agree to join in the conference, you can release the
party and get back with whom you are already in conference.

 
FIGURE 6-14

 6.7.2 How Do You Conference Using Hot Key?
Press F7 function key to conference, when there is an active call. The Conference With dialogue box will
appear. Enter the number of the party to conference with.

 6.7.3 How Do You Conference from Call Control View?

 
 
Click on the Conference button to add a party to conference with, when there is an active call. You will get
the Conference With dialogue box. Enter the phone number of the party who is to be included in the
conference.

The connected party will go OnHold pending Conference. After the party agrees to join the conference,
press on the Conference button again to include the party in the conference. If the party does not agree to
join the conference, press on the Release button in the Call Control View to reconnect to the held party.
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 6.7.4 Other Ways to Conference

6.7.4.1 How do you conference using right click menu?

Select the contact with whom you want to conference in the Detailed List View and click the right mouse
button. A pop-up will appear. Select the Conference option to add the party into conference.

6.7.4.2 How do you conference using Drag and Drop?

Select the contact from the Detailed List View and drag the contact to the Call Control View to dial the
number of the contact. Click the Conference button once you are connected to the party, to include the
party in the conference.

 
 

 6.7.5 How Do You Drop Parties from Conference?
Select the party to be dropped from Conference. Click the right mouse button and select the Release option
to drop the party from Conference.

Warning: You can have a maximum of five party conference



75

 6.8 How Do You Make a New External Call?
To make a new external call on the seized trunk, click on the Call Control menu and select Make New
External Call option. You can dial another external number without dropping the trunk line.
 

 
FIGURE 6-15

Enter the phone number (do not include the trunk access code ) or select any of the last 10 numbers you
have dialled previously to make an external call. You can also Speed Dial to any of the five contacts by
clicking on them.
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 6.9 How Do You Dial Continuously to Make a Call?
Select the Continuous Dial option from the Call Control menu to dial continuously to connect to the last
number dialled.

FIGURE 6-16

 
If you want to redial before the time out occurs, click on the Dial button. Once you get connected to the
internal party the continuous dialling automatically stops; if you get connected to the external party, you
have to click the Stop button to stop continuous dialling. You can change the redialling duration in the
SetEnvironment ! Time Out option from the Options menu. The default redial duration is 30 seconds.

 6.10 How Do You Retrieve a System Held Call?
Click on the Call Control menu and then click on the Pick Up option. The Pick Up Call dialogue box will
appear. You can also get this dialogue box by pressing the Pickup button in Call Control View.
 

 
Enter the trunk number and press the System Hold Retrieval button.
 

 
If that particular trunk is held at some other station you will be connected to the trunk.
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 6.11 How Do You Pickup a Call?
You can answer a call for any other station which receives an incoming call and the call is not being
answered. You can answer that call using the Pick Up option.

 6.11.1 How Do You Pickup Using the Call Control Menu?
Click on the Call Control menu and then click on the Pickup option. The Pick Up Call dialogue box will
appear (Figure 6-17). You can either pick up a call from any station or from any other group.
 

 
FIGURE 6-17

6.11.1.1 How do you pickup a call from another station?

Dial the extension of the station using the Pick Up Call dialogue box or use the pull-down menu to choose
any of the last 10 numbers dialled to pick up a call from a ringing station. If the station is in your Fast
Station Pickup list, select the station and click the Station Pick Up (Stn P/U) button.

6.11.1.2 How do you pickup a call from another group?

Dial the group number using the Pick Up Call dialogue box or use the pull-down menu to choose any of
the last 10 group numbers dialled to pick up a call from a ringing station in another group. Press Group
Pick Up (Grp P/U) button.

 6.11.2 How Do You Pickup a Call from Call Control View?
Click on the Pickup Button in the Call Control View to pick up a call from a ringing station or group.
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 6.12 How Do You Pickup a Call from a Universal Answer Device?
You can pick up a call from a universally answerable device by dialling the universal answer code. Click on
the Call Control menu and then click on the Universal Answer option.

 6.13 How Do You Toggle Between Calls?
In the case of a Consultation Transfer, if the third party does not agree to speak to the calling party, you can
toggle between these two parties.

 6.13.1 How Do You Toggle Calls from Call Control Menu?
Click on the Toggle option in the Call Control menu only after the Consultation call is connected.

FIGURE 6-18

After selecting the Toggle option, the active call goes into OnHold transfer state and the held call becomes
active in the Call Control View.

FIGURE 6-19
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 6.13.2 How Do You Toggle Calls from Call Control View?

 
Click on the Toggle button in the Call Control View to toggle between calls.

 6.14 How Do You Hook Flash a Call?
You can send Hook Flash on the C.O line or a PBX line using this option.
Click on the Call Control menu and then click on the Hook Flash option. For example, if you have an
external active call, you can hook flash if you wish to transfer this call to an extension which belongs to the
main PBX and your PBX is connected behind this PBX. Or in some cases you may want to send hook flash
to your C.O or Centrex.
 
Note: Hook Flash will not work properly if the trunk is not configured as a PBX line.

 6.15 How Do You Page to a Zone?

Click on the Page option in the Call Control menu or the Page button in Call Control View to get the Page
dialogue box. You can page to the zones you have selected from the pull-down menu. You can page to all
individual zones, all external zones or all internal zones.
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FIGURE 6-20

 
 
 
 
 

Note: You have to lift the handset of your Keyset before you select the above option
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 6.16 How Do You Send DTMF(Dual Tone Multi Frequency) Tones?

When a call is connected you can send DTMF tones using the menu option Call Control/Send DTMF….

The following dialogue box appears.

FIGURE 6-21

Note: DTMF tones are sent immediately when you click the buttons on the dialogue box
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 6.17 How Do You Call Back a Station?
If you dial a station which is busy or which does not answer, you can ask that station to call you back. The
called station rings back to the caller, once the station becomes idle.

 6.17.1 How Do You Call Back from the Call Control Menu?
Select the Call Back option in the Call Control menu.

 6.17.2 How Do You Call Back a Station Using Hot Key?
Press F10 function key to request the other station to call you back.

 6.17.3 How Do You Call Back a Station from the Tool Bar?

 
Click on the Call Back button in the Station Control Tool Bar to set a station to call you back.

 6.17.4 Other Ways to Call Back a Station
If you call a station which is busy, you can request the station to call back by choosing the Call Back button
in the Station Busy dialogue box (Figure 6-22).

 6.18 How Do You Leave Message for Another Station?
If you dial a station which is busy or which does not answer, you can leave a message for this party.

 6.18.1 How Do You Leave a Message from the Call Control Menu?
If you want to leave a message on a station, select the Leave Message option in the Call Control menu. This
message will be shown in the Message List dialogue box of the called station.
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 6.18.2 How Do You Leave a Message from the Tool Bar?
 

Click on the Leave Message button in the Tool Bar menu to leave a message for the called station.

 6.18.3 Other Ways to Leave a Message
If you call on a station, which is busy, you can leave a message for the station by choosing the Leave
Message button in the Station Busy dialogue box (Figure 6-22).

 6.19 How Do You Camp On to Another Station?
If you dial a station which is busy, you can notify the station that your call is waiting.

 6.19.1 How Do You Camp On from the Call Control Menu?
Select the Camp On option from the Call Control menu. The camped-on station receives a tone indication
that your call is waiting. The other station could either ignore your call or put its active call on hold and
answer your camped on call.

 6.19.2 Other Ways to Camp On
If you call on a station which is busy, you can notify the station that your call is waiting by choosing the
Camp On button in the Station Busy dialogue box (Figure 6-22).
You can also press F9 to camp on if the called station is not answering.

 6.20 How Do You Make an OHVA (Off Hook Voice Announce)?
If you have called a busy station and you have a voice announcement, select the OHVA option in the Call
Control menu. The busy station will receive the Off Hook Voice Announce about your waiting call while
the station is in conversation.
 
 
 
 

Note: If the station is set to DND, it will not receive an OHVA call.
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 6.21 What Happens When You Dial a Busy Station?
If you call a station which is busy, the Station Busy dialogue box will appear, from which you can choose
the type of operation you want to perform.

FIGURE 6-22

 
Click on Call Back button, if you want to set a call back on the busy station

 Click on the Leave Message button, if you want to leave a message for the
busy station

 Click on the Camp on button, if you want to notify the busy station about your
call is in waiting

 
Click on the OHVA button, if you want to intrude on the busy station

 Click on the Schdule button, if you want to reschedule this call at some other
time

 
Click on the Release button, if you want to release the call.

TABLE 6-5
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 6.22 What Happens if the Trunk is Busy When You Dial an External
Number?

When you dial an external number and the trunk is busy, the Trunk Busy dialogue box will be displayed to
help you to quickly set the available options such as call back, redial etc.

FIGURE 6-23

Click on Call Back button, if you want to set a call back on the trunk
or trunk group

Click on the Redial button, if you want to redial the number

Click on the Conti Dial button if you want to continuously dial the
number

Click on the Schdule button, if you want to reschedule this call for
some other time

Click on the Release button, if you want to release the call.

TABLE 6-6
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 6.23 What Happens When You Answer the Trunk Call Back Call?
If you have set a call back for a trunk when you dialled an external number from Smart Control, the dial pad
will come up and display the number to be dialled when you answer the trunk call back.

 6.24 How Do You Enter Call Note and Keyword for a Call?
To make notes related to a call, select the call and click the right mouse button and select Call Note option.
The Call Note dialogue box will be displayed.

FIGURE 6-24

Enter the call note and keyword (Identifier) and press OK button to save the call note and the keyword.

The call note will be stored along with the call details in the call log. You can retrieve them later from the
call log.
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                                                                                7

DIRECTORY SERVICES
 
 
 
This section explains about the Directory Services provided in the Smart Control application. Directory
Services is maintained in a local database and a network database. In both of these, you have a Business
phone book, an Others phone book and a Personal phone book.

These are default phone books. The Personal phone book is listed by default in the Detailed List View when
Directory Services is accessed. Under the local database, you also have a FindResults phone book which
holds the result of the last find operation.
 
The table below explains the various menus and options associated with Directory Services:

Menu Options Description

Print Prints the selected phone book

Fields to Print Sets up the printing parameters for a pageFile

Print Preview Shows preview of a page before printing

New Contact Adds a new contact to a phone book

Edit Contact Modifies the selected contact in a phone book

Delete Contact Deletes the selected contact from a phone book
Edit

Delete All Contacts Deletes all the contacts from the selected phone book
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Menu Options Description

New Book Adds a phone book

Delete Book Deletes a phone book

Rename Book Renames the existing phone book

Accesses a network phone book

Connect Connects to the network phone book

Directory

Network
PhoneBook

Disconnect Disconnects from the network phone book

Imports or exports a phone book in Smart Control

Import
(Act 2.0)

Imports an ACT! 2.0 for Windows database

Import
(Act 4.0)

Imports an ACT! 4.0 for Windows database

Import
(*.sam)

Imports the Smart Control (*.sam) phone book file

Import
(PS2000)

Imports PS2000 database

Import
(Outlook)

Imports the Microsoft OutLook database

Import / Export

Export Book Exports a Smart Control phone book to a file

Search Searches the given string in the phone book database

TABLE 7-1
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If you click the right mouse button in the Selection View, you will get the following menu items.
 

Item Purpose

New Book Adds a new book

Delete Book Deletes a new book

Rename Book Renames the existing phone book

Connect Connects to a network phone book

Disconnect Disconnects from a network phone book

Export Exports all the contacts from the selected phone book to a file

Import (*.sam) Adds contacts in a selected phone book from a file

Hide View Hides the Selection View

Icon/Tree View Switches between Tree View and Icon View

TABLE 7-2

 
If you click the right mouse button in the Detailed List View, you will get the following menu items.
 

Item Purpose

New Contact Adds a new contact to a phone book

Edit Contact Modifies the selected contact in a phone book

Print Contact Prints the selected contact using the print options you selected

Delete Contact Deletes the selected contact from a phone book

Delete All Deletes all the contacts from the selected phone book

Export book Exports all the contacts from the selected phone book to a file

Import (*.sam) Adds contacts in a selected phone book from a file

Dial Dials the office phone number of the contact

Schedule Call Schedules a call to office phone number of the contact

Transfer Transfers a call to office phone number of the contact

Conference Adds contact to conference at office phone number

TABLE 7-3



Smart Control User Guide 90

Drag and Drop

Drag and Drop a contact from
Detailed List View to Call Control
View

Dials the contact at office number if there is no active call

Adds this contact to the conference if there is an active call

Drag and Drop a contact from
Detailed List View (Extension
Column) to Call Control View

Dials the extension number of the contact if there is an active call

Drag and Drop a contact from
Detailed List View to Call Control
View (by pressing the CTRL key)

Transfers the active call to this contact

Drag and Drop a contact from
Detailed List View to Selection
View

Copies the Selected Contacts to the phone book selected

TABLE 7-4

 7.1 What is a Phone Book?
A group of contacts is called a phone book. A phone book can have any number of contacts. You can create
your own phone books and delete them.

 7.2 What are the Default Phone Books?
The default phone books will always be there in the system. The default phone books cannot be deleted.
They are Business, Others, Personal and FindResults.

 7.3 What is a Network Phone Book?
The phone book which is not local to your system and exists on the network is the network phone book.

 7.4 What is a Contact?
Each entry of a phone book is termed a contact. A contact has a Name, Company, Office Phone No.,
Extension, Home No., Mobile Phone No., etc. You can create as many contacts as you wish. You can also
edit and delete these contacts.
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 7.5 How Do You Add a New Phone Book?

 7.5.1 How Do You Add a New Phone Book from the Directory Menu?
Select the folder in which the phone book is to be created in the Selection View. Select Local or Network,
then click on the Directory menu, and choose New Book option to create a new book.

In Selection View, depending on whether you are in the Tree View or Icon View, you will get a new phone
book folder or a new phone book icon with a default name dir(n). You can create as many new phone books
as you want.

 
 
 
 

 7.5.2 Other Ways to Add a New Phone Book
You can also click the right mouse button on the folder of the directory in the Selection View and click on
the New Book option.

FIGURE 7-1

Note: You cannot have spaces when naming a phone book. Duplicate name is not allowed.
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 7.6 How Do You Delete a Phone Book?

 7.6.1 How Do You Delete a Phone Book from the Directory Menu?
Select the phone book you want to delete from the selection View.

Click on the Directory menu and choose the Delete Book option.  It will ask for confirmation:

FIGURE 7-2

Click on Yes, if you are sure, otherwise click No.
 
 
 
 
 
 
If you are in the Tree View and the phone book is deleted successfully, the phone book folder is removed.
If you are in the Icon View, the phone book icon is removed.

 7.6.2 Other Ways to Delete a Phone Book
You can also click the right mouse button in the Selection View and then click on Delete Book option to
delete the selected phone book.

 7.7 How Do You Rename a Phone Book?

 7.7.1 How Do You Rename a Phone Book from the Directory Menu?
Click on the phone book in the Directory menu and select Rename Book option. This will allow you to
edit the name of the phone book in Selection View.

Note: The default phone books and Search Results phone book  cannot be deleted.  If you are
trying to delete a phone book in the Network, you need to have the access permission to delete
it.
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 7.7.2 Other Ways to Rename a Phone Book
You can also click the right mouse button in Selection View and then click on Rename Book option to
rename the selected phone book.

 7.8 How Do You Add a Network Phone Book?

 7.8.1 How Do You Add a Network Phone Book from the Directory Menu?
Click on Network PhoneBook option in the Directory menu, then choose Connect option.

FIGURE 7-3

 
You will get a pop-up Open dialogue box where you can select the network phone book you would like to
access. If you are already connected to the Smart Control network phone book, you have to disconnect it to
reconnect to the other network phone book. Only one network phone book at a time is allowed.

Network PhoneBook folders are added in Tree View. In Icon View,  the Network button is enabled.

 7.8.2 Other Ways to Add a Network Phone Book
When you are under Directory Services, you can also choose the Connect option by clicking the right mouse
button in Selection View to connect to a network phonebook.

Note: If you have  connected to a network phone book while closing the  application, the next
time you start your application, the network phone book connection would be restored..
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 7.9 How Do You Remove a Network Phone Book?

 7.9.1 How Do You Remove a Network Phone Book from the Directory Menu?
Click on Network PhoneBook in the Directory menu then choose Disconnect option. The network phone
book will be disconnected.

 7.9.2 Other Ways to Remove a Network Phone Book
You can also choose the Disconnect option by clicking the right mouse button in Selection View.

 7.10 How Do You Import/Export a Phone Book?
By importing, you can append an existing phone book to the Smart Control directory database; and by
exporting, you can export a phone book to a file.

Click on the Import/Export option in the Directory menu to Import/Export a phone book.
 

 
FIGURE 7-4

 
If you are already using an application such as ACT! 2.0 or ACT! 4.0 for Windows, PS2000, or Microsoft
OutLook as a Contact Manager, you can import the database into Smart Control without modifying it.
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 7.10.1 How Do You Import ACT! 2.0 Database?
The ACT! 2.0 database can be imported into the phone book of your choice by clicking on Import…(Act
2.0)…  option in the Directory menu Import/Export option. All the contacts in your ACT! 2.0 database will
now be added to your selected phone book.

When you are importing the database under this option, ensure that you have *.dbf and *.fpt files in the
same directory. Now select *.dbf in the Open dialogue box and the ACT! 2.0 database file gets field
mapped into Smart Control as follows:
 

Smart Control database ACT! 2.0 database

Name CONTACT

Company name NAME

Office street name ADDR1

Office city CITY

Office zip code ZIP

Office state STATE

Home street name ALT_ADDR1

Home city ALT_CITY

Home zip code ALT_ZIP

Home state ALT_STATE

OfficeNo1 PHONE

Office1Extn EXT

OfficeNo2 ALT_PHONE

Office2Extn ALT1_EXT

Other No ALT2_PHONE

Fax No FAX_PHONE

Job title TITLE

Mobile CAR_PHONE

Notes NOTES

TABLE 7-5
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 7.10.2 How Do You Import ACT! 4.0 Database?
The ACT! 4.0 database can be imported into the phone book of your choice by clicking on
Import…(Act4.0)…  option in the Directory menu Import/Export option. All the contacts in your ACT! 4.0
database will now be added to your selected phone book.

Now select *.dbf in the Open dialogue box and the ACT! 4.0 database file gets field mapped into Smart
Control as follows:

Smart Control database ACT! 4.0 database

Name NAME

Company name COMPANY

Office street name ADDR1

Office city CITY

Office zip code ZIP

Office state STATE

Office Country COUNTRY

Home street name ADDR1

Home city ALTCITY

Home zip code ALTZIP

Home state ALTSTATE

Home country ALTCOUNTRY

OfficeNo1 PHONE



97

Smart Control database ACT! 4.0 database

Office1Extn EXT

OfficeNo2 PHONE2

Office2Extn PHONE2_EXT

Other No PHONE3

Other Extn PHONE3_EXT

Direct No ALTPHONE

HomeNo1 HOME_PHONE

Pager PAGER

Fax No FAX_PHONE

Job title TITLE

Mobile MOBILPHONE

Web URL

TABLE 7-6
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 7.10.3 How Do You Import PS2000 Database?
The PS2000 database can be imported into the phone book of your choice by clicking on
Import…(PS2000)…  option in the Directory menu Import/Export option. All the contacts in your PS2000
database will now be added to your selected phone book.

Now select *.mdb in the Open dialogue box and the PS2000 database file gets field mapped into Smart
Control as follows:
 

Smart Control database PS2000 database

Name Name + lname

Company name Company

DeptName Department

Office street name Address

Office city City

Office zip code ZipCode

Office state State

OfficeNo1 cnty-area-number

OfficeNo2 cnty-area-number

Other No cnty-area-number

Direct No cnty-area-number

HomeNo1 cnty-area-number

Job title Title

Picture Picture

TABLE 7-7
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 7.10.4 How Do You Import *.SAM File?
The *.sam file can be imported into the phone book of your choice by clicking on Import…(*.sam)…
option in the Directory menu Import/Export option. All the contacts in your *.sam file will now be added to
your selected phone book.

7.10.4.1 Other ways to import a *.sam file

You can click the right mouse button in the Selection View, when you are under Directory Services, or
click the right mouse button in the Detailed List View to get the Import…(*.sam)… option.

 7.10.5 How Do You Import Outlook Database?
If you are importing a Microsoft OutLook file, you first have to export the Outlook file in Microsoft Access
format (*.mdb). The fields to be exported are as follows:
 

Field Name

Name
Company
Department
Business address
Home address
Business phone
Business phone 2
Other phone
Home phone
Home phone 2
Email
Pager
Business fax
Web Page
Job title
Mobile phone

 
Once these fields are exported from OutLook in *.mdb format, select the phone book in Smart Control that
you want to import these fields into and choose Import…(Outlook)… in the Directory menu Import/Export
option. Now select the *.mdb file from the Open dialogue box. The *.mdb file gets field mapped into Smart
Control as follows:
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Smart Control database OutLook database

Name Name

Company name Company

Department Department

Office street name Business address

Home street name Home Address

OfficeNo1 Business phone

OfficeNo2 Business phone2

OtherNo Other phone

HomeNo1 Home phone

HomeNo2 Home phone1

Email Email address

Pager Pager

Faxno Business fax

Job title Job title

Mobile Mobile phone

WebPage Web Page

TABLE 7-8
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 7.10.6 How Do You Export a Phone Book to a File?
You can export a Smart Control phone book to a file by using the Export Book option.

Click on the Directory menu Import/Export option and choose Export Book option. You will get a Save As
dialogue box where you can save the selected phone book. The default file extension is *.SAM. You can
also use a file extension name of your choice.
 
 
 
 

7.10.6.1 Other ways to export a phone book

You can click the right mouse button in the Selection View, when you are under Directory Services, or
click the right mouse button in the Detailed List View to get the Export Book option.

 7.11 How Do You Print Contacts From a Phone Book?
 

 
FIGURE 7-5

 
This prints all the contacts in your phone book. You have the option to select one of four different types of
formats for printing. You can preview the output on screen  before printing it.

To print the contents of a phone book you have selected in the Selection View, click on the Print option in
the File menu. The listing in the printout depends upon the options you have selected in the Information To
Print dialogue box (Figure 7.6). The output will appear like this:

Name  : Mohan Rajan

Profession  :Software Engineer, Telecom, SISO

Warning:  If the fields indicate ERROR in the Detailed List View, the Import/Export operation
has failed.
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Company Contact  :
Address : 1001, Prestige Meridian
First No : 91-80-509 8007-extn-142
Second No :
Other No :
Direct No :
Internal No : 201

Home Contact :
Address : 105, Lake Side Residency
First No :
Second No :
Farm No:
GuestHouse No :

Other Contact Nos :
Fax : 91-80-555 0558
Mobile :
Pager
Email : mohanraj@samsung.co.kr
-----------------------------------------------------

 7.11.1 How Do You Set Up Fields for Printing?
You can select the individual items of information to be printed by selecting options from the Information
To Print dialogue box.

FIGURE 7-6

Click the Fields to Print option on the File menu. The Information To Print dialogue box will appear with
five checkbox options. Select the option or options for which you want a print out.
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 For example, if you want a printout of a phone book listing only the professional details, check against the
Profession checkbox and deselect the rest of the checkboxes.

If Select All option is checked, all the other options get checked. Figure 7-6  shows all the options checked,
so in this case you would get a printout of all the details in the phone book you have selected in the
Selection View.

 7.11.2 How Do You Preview the Printout?
You can preview the print output on the screen by clicking on Print Preview option in the File menu.

 7.12 How Do You Add a New Contact to a Phone Book?
 

 
FIGURE 7-7

 7.12.1 How Do You Add a New Contact Using the Edit Menu?
Click the New Contact option in the Edit menu to add a new contact to the phone book which is selected in
Selection View.

On clicking this option, the Add Record dialogue box will appear into which relevant information is to be
entered.
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FIGURE 7-8

" Personal Info page

Enter the data for the fields Name, Company Name, Job Title etc. For example, in the Job Title field, you
have a pull-down menu containing job titles; you can select the job title from the menu or enter your own
job title.

For the Edit Address field, you can select the type of address from the address pull-down menu and click on
the Edit Address button to enter the details.

FIGURE 7-9

Note: Name or Company Name must be entered
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The Note button is used to launch Notepad with the <namecompanyname>.txt file, so you can enter any
notes for this contact. The file will be stored in the SmartControl\ContactNotes directory. Because it uses
the name and company name you entered as the file name, be precise in what text you enter in these fields.

The Email button is for launching the registered default email application.
 
To insert a bitmap image (picture) of the contact, click the Browse button on the Personal Info page of the
dialogue box and select the bitmap file.
 
To enter phone numbers, click on the Contact Info tab.

" Contact Info page:

FIGURE 7-10
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Pull-down menus are provided to enter different Office/Home phone numbers. You select the Office phone
type from the Office phone pull-down menu to enter the office phone numbers and the extension phone
number in the Extn field.

The phone number field starts with Country code-Area code (in this example, 91-080). Smart Control picks
up the country code and area code from the Telephony dialling properties of your system.
 
 
 
 
 
 
 
 
Click the OK button to add a contact, or the Cancel button if you decide not to add this contact. If you wish
to add another contact, click  the Add Next button.

The entered contact gets appended to the database file and a blank Add Record dialogue box appears with
the Personal Info tab selected.
 
 
 
 

 7.12.2 Other Ways To Add a New Contact
You can also add a new contact by clicking the right mouse button in the Detailed List View.

 7.13 How Do You Edit a Contact?

 7.13.1 How Do You Edit a Contact Using Edit Menu?
Select the phone book contact in the Detailed List View and click on the Edit Contact option. An Update
Record dialogue box will appear where you can modify the entries for the desired contact.

Note:  Whichever Office No. or Home No. is selected, it will appear in the respective fields in
the Detailed List View

Note: If you click on the phone icons next to the fields in this dialogue box, you automatically
dial the number entered in the field.

Warning : Smart Control does not accept ‘-’ within a phone number except the ‘-’ between
country code and area code. The format is CNTY-AREA-PhoneNumber
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FIGURE 7-11

Click on the Prev or Next button to edit the previous or next record in the selected phone book. If you click
on Prev or Next button after modifying a contact, those modifications will be saved automatically.

 7.13.2 Other Ways to Edit a Contact
You can also edit an existing contact by:
 
* Clicking the right mouse button after selecting the phone book contact in the Detailed List View and

then clicking on Edit Contact option.
* Double clicking on the selected contact in the Detailed List View.

Note:  The Edit option is enabled in the Detailed List View only when a contact.has been
selected
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 7.14 How Do You Delete Contacts?

 7.14.1 How Do You Delete Contacts from Edit Menu?
Select the phone book contacts in the Detailed List View and click the Delete Contact option in the Edit
menu to delete the selected contacts from the phone book.

 7.14.2 Other Ways to Delete Contacts
You can also delete a selected phone book contact from the Detailed List View by clicking the right mouse
button and then selecting the Delete Contact option.

 7.15 How Do You Delete All Contacts?

 7.15.1 How Do You Delete All Contacts from the Edit Menu?
You can delete all contacts in a selected phone book by clicking the Delete All Contacts option in the Edit
menu.

 7.15.2 Other Ways to Delete All Contacts
You can also delete all records in the selected phone book from the Detailed List View by clicking the right
mouse button and then clicking on the Delete All option.  It will ask for confirmation.

Click on Yes, if you are sure, otherwise click on No.

 7.16 How Do You Search for a Particular Contact?
You can search for a contact in the Local and Network phone book databases. The search results appear in
the FindResults phone book. Any changes you then make to the search results will be reflected in the
original phone book database containing the contact.

Select the Search option in the Directory menu and enter the text you want to search for in the Find Text in
Phone Book dialogue box. Click OK. The contacts which match the text entered will be added to the
FindResults phone book (any contacts previously in the FindResults phone book will be deleted).
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FIGURE 7-12

 7.16.1 Find Results After Using the Search Option
Click the right mouse button on the selected contact in the Detailed List View. A pop up will appear with
which you can perform various operations on the searched results.

FIGURE 7-13
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You can do the following.

Click on Edit Contact option to get details of the contact in the Update Record dialogue box. Here, you can
update the contacts in the FindResults phone book. The changes made here will be reflected in the original
phone book.

Click on Hide Contact option and the selected contact(s) will be hidden. The contact(s) will be deleted only
from the FindResult phone book.

Click on Hide All option and all the contacts will be hidden. The contacts will be deleted only from the
FindResults phone book.

Click on Export Results option. An Open dialogue box will appear. Enter a filename under which those
contacts that have been displayed are to be kept. Those contacts can later be imported using the Import
option.

Click on Dial option and it will dial the number of the selected contact. The number will be selected based
on the current cursor position.

Click on Schedule Call option. An Add Schedule dialogue box will appear where you can schedule a call.
The number will be selected based on the current cursor position.

If there is a connected call, click on Transfer option, so that the call will be transferred to the number of the
selected contact. The number will be selected based on the current cursor position.

If there is an active call in the Call Control View, click on Conference option, so that the number of the
selected contact will be put into conference. The number will be selected based on the current cursor
position.

The system also supports Drag and Drop for copying, dialling, transferring a call and conferencing.

 7.16.2 Change in File Menu After Searching
The File menu now supports the printing of contacts found after searching.

 7.16.3 Change in Edit Menu After Searching
The following features will now be added to the Edit menu after selecting any of the searched results:
Hide Contact option—the selected contacts will be deleted from the FindResults phone book.
Hide All option—all the contacts in the FindResults phone book will be deleted.

Note: You can also drag and drop from Office no., Home No., Pager  or Mobile to make a call.
By default, the office phone number is dialled.
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 7.17 Directory Services in Detailed List View

FIGURE 7-14

This displays the contents of the selected phone book in the Detailed List View. The fields listed are Name,
Company, Office Phone, Extn., Home Phone and Mobile.

 7.17.1 How Do You Sort Contacts?
You can sort the list according to Name, Company, or Mobile field in ascending or descending order by
clicking on the respective column headers.

When you click on the column header, it will sort in ascending order on that field. If you want to sort it in
descending order, click the header again.
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 7.17.2 How Do You Add a Contact?
Click the right mouse button in the Detailed List View and choose New Contact option to add a new contact
in your phone book.

 7.17.3 How Do You Edit a Contact?
Click the right mouse button in the Detailed List View and choose Edit Contact option to modify an existing
contact in your phone book.

 7.17.4 How Do You Delete a Contact?
Click the right mouse button in the Detailed List View and choose Delete Contact option to delete the
selected contact from the phone book.

 7.18 How Do You Delete All Contacts from Your Phone Book?
Click the right mouse button in the Detailed List View and choose Delete All option to delete all the
contacts from the phone book.

Once you choose the Delete All option, it will ask for confirmation.

Click on Yes, if you are sure, otherwise click No.

 7.19 How Do You Dial a Contact?
Select the contact from the phone book in the Detailed List View and click the right mouse button.

Choose the Dial option to dial. Dial option dials the number of the selected contact. The number will be
selected based on the current cursor position.

 7.20 How Do You Schedule a Call to a Contact?
Select the contact from the phone book in the Detailed List View and click the right mouse button in the
Detailed List View.

Choose the Schedule Call option to schedule a call to the number of the contact. The number will be
selected based on the current cursor position.
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 7.21 How Do You Transfer a Call to a Contact?
Select the contact from the phone book in the Detailed List View and click the right mouse button in the
Detailed List View. If you have an active connected call in the Call Control View, you can transfer this call
to the number of the selected contact by clicking on Transfer option.

The number will be selected based on the current cursor position.

 7.22 How Do You Add a Contact to a Conference?
Select the contact from the phone book in the Detailed List View and click the right mouse button in the
Detailed List View.

If you have an active call in the Call Control View, you can include this contact in the ongoing conversation
by clicking the Conference option.

This dials the number of the contact. The number will be selected based on the current cursor position.

 7.23 How Do You Print a Single Contact?
Click the right mouse button in the Detailed List View after selecting a contact, then choose Print a Contact.

The selected contact will be printed with the options set in Page Setup.
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8

DRAG & DROP SERVICES

You can click the mouse button on a contact in the Detailed List View and drag it across Selection View or
Call Control View to perform various functions such as dialling, transferring a call and conferencing. This
operation is called Drag and Drop.

Item Purpose

Dragging to the Selection View Copies the selected contacts to the phone book
selected

Dragging to the Call Control View
If there is no connected call, it dials.  If there is a
connected call, a conference is established with
this contact

CTRL+Drag to Call Control View Transfers the connected call to this contact

Dragging Extension to Call Control View Dials the extension number if the call is connected

Dragging Home number to Call Control View Dials the home number

Dragging Mobile number to Call Control View Dials the mobile number

Dragging Pager number to Call Control View Dials the Pager number

TABLE 8-1



Smart Control User Guide 116

 8.1 Drag and Drop - How Do You Copy Contacts Across Phone
Books?

Select the contact to be copied in the Detailed List View. Drag it into the Selection View and drop it into the
phone book you wish to copy to. The cursor will show Copy.

 8.2 Drag and Drop - How Do You Dial?
Select the phone book contact in the Detailed List View. Drag and drop into the Call Control View to dial a
phone number.

If you drag from the Name, Company, Office Phone or Extn and drop in the Call Control View, by default
the office phone number is dialled. If you drag from the Home Phone column and drop into the Call Control
View, the home phone number is dialled.

If you drag from the Mobile Phone column and drop into the Call Control View, the Mobile Phone number
is dialled.

 8.3 Drag and Drop - How Do You Transfer a Call?
When there is an active call, press the CTRL key and drag the contact from the phone book in the Detailed
List View and drop into the Call Control View to transfer the call to the selected contact.

 8.4 Drag and Drop - How Do You Conference a Call?
When there is an active call, drag the contact from the phone book in the Detailed List View and drop into
the Call Control View to add the contact to conference.

 8.5 Drag and Drop - How Do You Dial an Extension?
When there is an active call, drag the extension from the phone book in the Detailed List View and drop
into the Call Control View to dial the extension number.

Note:  If you drag the mouse cursor from Detailed List View to Call Control View, the cursor
shows Dial.  If you drag the mouse cursor from Detailed List View to Selection View, the cursor
shows Copy.
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                                                                                9

SCHEDULER SERVICES

This chapter tells you about the Scheduler Services provided in Smart Control. You can schedule outgoing
calls, set/reset different types of call forwarding, set/reset DND (Do Not Disturb) and set/reset Vacant
Station Messages.

 9.1 What is a Schedule?
It is a service which is triggered at a set date and time.

Scheduler Services can be viewed both in Tree view or Icon view in Selection View. When you click on
Scheduler, it displays the contents of All Scheduled records in the Detailed List View by default.

The Detailed List View displays the scheduled function, details, frequency of the scheduled function and the
time during which the scheduled function is active.

You can view different Schedule functions in the Detailed List View by selecting them in Selection View.

For example, when Outgoing Call is selected in Selection View, you can view the scheduled outgoing calls
in Detailed List View.

Item Purpose

Function Shows the function set for a scheduled item such as DND, outgoing call,
forwarding, etc.,

Detail Shows the details of the scheduled item such as destination number, vacant
station message number, etc.

Frequency Shows the frequency set for the scheduled item: once, daily, weekly or
yearly.

Time Shows the time set for the scheduled item

State Shows the state of the schedule item such as completed, scheduled,
rescheduled, etc.

Note Shows the message entered in the schedule note
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Item Purpose

New Schedule Adds a new schedule

Edit Schedule Modifies a schedule

Delete Schedule Deletes a schedule

Delete All Deletes all the selected schedules

TABLE 9-1

 9.2 How Do You Add a New Schedule?

 9.2.1 How Do You Add a New Schedule from Edit Menu?
Click on Edit menu and select New Schedule option. You will see the Add Schedule dialogue box.

FIGURE 9-1

You can choose one of the items you want to schedule at any one time. Depending upon the item selected,
different controls will be enabled or disabled.
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9.2.1.1 How do you schedule a Do Not Disturb?

If you wish not to be disturbed by incoming calls for a selected time, or on some day:

Click on Edit menu and select New Schedule option to get the Add Schedule dialogue box.

FIGURE 9-2

Click on Do Not Disturb option. You can also enter a comment in the Schedule Note field, if required.
Now click on the Frequency tab and enter the Date, Time and Frequency for the DND option to be active
(see Section 9.3 for details).
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9.2.1.2 How do you schedule a Call Forward?

If you wish to forward your calls to some other station at a selected time or on some day:

Click on Edit menu and select New Schedule option to get the Add Schedule dialogue box.

FIGURE 9-3

Click on Call Forward option. Select the type of calls to be forwarded in the Type of calls pull-down menu.
In the Destination field, enter the phone number to which the call is to be forwarded. You can also enter a
comment in the Schedule Note field, if required.

Now click on the Frequency tab and enter the Date, Time and Frequency for Call Forward to be active
(see section 9.3 for details).
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9.2.1.3 How do you schedule a call?

If you wish to make a call to some number at a selected time or on some day:

Click on Edit menu and select New Schedule option to get the Add Schedule dialogue box.

FIGURE 9-4

Click on Out Going Call option. Enter the phone number in the Destination field. You can enter any
comments in the Schedule Note field.

The Schedule Note will be shown as Call Note when the call is made, for example: “Birthday Greeting”.
Now click on the Frequency tab and enter the Date, Time and Frequency for Out Going Call to be active
(see Section 9.3 for details).

If a contact pop up is needed when the outgoing call is being made,  select the contact pop up. It will pop
up the property sheet if the contact information is available in the directory database.

9.2.1.4 How to schedule a Vacant Station Message?

If you will not be available at your work place or station to receive a call for a selected time or on some
day,  you can set a Vacant Station Message for this time or on this day:
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Click on Edit menu and select New Schedule option to get the Add Schedule dialogue box.

FIGURE 9-5

Click on Vacant Station Message option. You can select the message in the Message pull-down menu.
You can also enter any comments in the Schedule Note field.

Now click the Frequency tab and enter the Date, Time and Frequency for Vacant Station Message to be
active (see section 9.3 for details).

 9.2.2 Other Ways to Schedule a Call
Select a contact in the Detailed List View. Click the right mouse button on the contact and choose the
Schedule option to schedule a call to this contact.

Note: In all the above functions, Schedule Note and Remind are optional.
If the Remind check box is selected, the system will remind you of the schedule before it is
executed. You have the option at this time to either terminate the schedule or to execute it
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 9.3 Frequency Option in Scheduler
This is used to set a time, date and frequency for execution of the scheduled item.

FIGURE 9-6

You can choose any one option from the Frequency pull-down menu. Depending on the type of frequency
selected, certain fields may be enabled or disabled. These fields can be used to enter the day, date and time.

 9.3.1 How Do You Schedule an Item Once?
If you select Once option, the scheduled services will be executed only once for the date and time you enter.

 9.3.2 How Do You Schedule an Item Daily?
If you select Daily option, the scheduled services will be executed every day at the time you enter.

 9.3.3 How Do You Schedule an Item Weekly?
If you select Weekly option, the scheduled services will be executed weekly on the day of the week and at
the time you enter. You can select the day of the week from the Day pull-down menu.
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 9.3.4 How Do You Schedule an Item Yearly?
If you select Yearly option, the scheduled services will be executed yearly on the day of the year and at the
time you enter.

 9.4 Reminder Option in Scheduler
If you wish to be reminded before a scheduled item is activated, check  the Reminder option box.

At the scheduled time a dialogue box will pop up to ask for confirmation of continuation of the schedule. If
a wave file is configured to be played for the Reminder, it will be played along with it.

If you click on “No” the scheduled item is not activated. The dialogue box will remain for 10 seconds after
which it will be assumed that the answer to the confirmation is “No” and the scheduled item is not activated.

 9.5 How Do You Edit a Schedule?

 9.5.1 How Do You Edit a Schedule from Edit Menu?
If you have any change in plans and you have scheduled a service, you can modify the schedule using the
Edit Schedule option from the Edit menu.

 9.5.2 Other Ways to Edit a Schedule
You can edit a selected schedule in the Detailed List View by clicking the right mouse button and then
clicking on Edit Schedule.

 9.6 How Do You Delete Schedules?

 9.6.1 How Do You Delete Schedules from Edit Menu?
Select the scheduled items to be deleted from the Detailed List View, and click on Delete Schedule in the
Edit menu.
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 9.6.2 Other Ways to Delete a Schedule
You can delete a selected schedule in the Detailed List View by clicking the right mouse button and then
clicking on Delete Schedule.

 9.7 How Do You Delete All Schedules?
If you want to delete all the scheduled items which are currently visible in Detailed List View, click on
Delete All option in the Edit menu. A Smart Control dialogue box will prompt for confirmation.

FIGURE 9-7

Click on Yes if you are sure, otherwise click on No.

 9.8 How Do You Sort Different Scheduled Items?

 9.8 How Do You Sort Different Scheduled Items?
To sort the schedules in Detail List View, click on the header for that particular column. For example, if you
click on Function,  it will sort all the scheduled items according to function (DND, Forwarding, etc.) Sorting
is available on Function, Frequency, Time and State.

Warning!  If you click on Delete All, all the scheduled items which are currently selected in
Selection View will get deleted (e.g. if DND folder/icon is selected in Selection View then all
the DND schedules will be deleted).
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10

CALL LOG SERVICES

This chapter tells you about the Call Log Services provided in Smart Control.

These services maintain the records of all incoming and outgoing calls. You can view the logs by selecting
the log type in the Selection View.

Contents of All will be displayed in the Detailed List View in descending date order by default.

Item Purpose

All To display both incoming and outgoing call details

Incoming Calls To display only incoming call details

Outgoing Calls To display only outgoing call details

TABLE 10-1

Fields in the Detailed List View.

Item Purpose

Name Displays the name of the caller/called party

From/To Displays number of the caller/called party

Date Displays the date when the call was made

Duration Displays the duration of the call

Call Note Displays the call note entry made after the call in the Call Control View
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Item Purpose

Identifier Displays the keyword entry made after the call in the Call Control View

Status

Displays the status of the call, such as:

RingBack—when you  have called a station and the party does not answer
Busy—when you have called a busy station
Connected—connected call
Unanswered—when there was a call to your station and you did not answer

DNIS Display the DNIS number of the call if any

TABLE 10-2

 10.1 How Do You View Call Logs?

 10.1.1 How Do You View All Call Logs?
If you select the All icon in the Selection View, you will get the logs for both incoming and outgoing calls
on your station displayed in the Detailed List View.

 10.1.2 How Do You View Incoming Call Log?
If you select Incoming Calls in the Selection View, all the incoming call log records will be displayed in the
Detailed List View.

 10.1.3 How Do You View Outgoing Call Log?
If you select Outgoing Calls in the Selection View, all the outgoing call log records will be displayed in the
Detailed List View.

 10.2 How Do You Sort Logs?

To sort the logs in Detail List View, click on the header for that particular column. For example, if you click
on Name, it will sort either in ascending or descending order of the name of the caller/called party
depending on which order they are currently in.

Sorting is available on Name, CallerId, Date, Duration, Status and DNIS.
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 10.3 How Do You Print a Call Log?

 10.3.1 How Do You Print a Call Log from File Menu?

FIGURE 10-1

Select the Print option from the File menu when you are in the Call Log Services to print all the call logs.
The options are:

Print - To print the Call Logs
Print Setup - To select the print format
Print Preview - To preview the print

 10.3.2 How Do You Set Up Different Types of Call Log Print Formats?
If you click the Print Setup option, the Select Format to Print dialogue box appears, from which the format
for printing can be selected.

FIGURE 10-2
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The printout in Detail View will appear as shown below:

Name  : Basheeruddin

Number  : 201

Date  : - - -

Duration  : 00:00:00

Call Note  : - -  -

Status  : Ring Back

Name  : - - -

Number  : 203

Date  : - - -

Duration  : 00:00:00

Call Note  : - -  -

Status  : Ring Back

 10.3.3 How Do You Preview the Print Output for a Call Log?
You can preview the printout on-screen by clicking the Print Preview option.

 10.4 How Do You Delete Logs?

FIGURE 10-3

Select the Delete Log option from the Edit menu.  The selected call log records will be deleted.
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 10.5 How Do You Delete All Logs?
Click the Delete All option.

FIGURE 10-4

 10.6 How Do You Save Note of a Call Log?
Right click on selected call log and select the Save Note option. A File Save dialogue box will appear.
Specify the file name and store the note in the *.txt file.

 10.7 How Do You Find a Log with Given Identifier?
Select the Find option from the Edit menu. A dialogue box will appear for the Identifier to be highlighted.
Click on OK button. If a call log with the given Identifier is available it will be highlighted in the Detailed
List View; if not, a  message box will appear saying that no log was found with the given Identifier.

 10.8 How Do You Print a Single Log?
Right click on the call log in Detailed List View and select Print Log. The log will be printed in detailed
format.

 10.9 How Do You Edit the Identifier and Call Note?
Right click on the call log in Detailed List View and select Edit Note. A property sheet will appear with the
call log details and the Identifier and Call Note fields to be edited. Make your changes and click on OK to
save the new details in the call log database.

Warning!  If you click on Delete All option, all the selected logs in Selection View will be
deleted. For example, if in Selection View the Incoming Calls folder/icon is selected, then
Delete All option will delete all the incoming call log records.
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 10.10 How Do You Redial from Call Log List View?
Right click on the call log in Detailed List View and select Redial. This will dial the number from the call
log list.

The phone number in incoming call logs is in CNTY-AREA-NUMBER format whereas the phone number
in outgoing call logs is formatted as the digits were dialled.

 10.11 DNIS Field in the Call Log
This field is introduced in call log records to denote the DNIS number, if any, in the call. This number is
shown as a separate field in the Detailed List View. For printing purposes and for the detailed property sheet,
this number is shown as part of the From/To field itself. It appears as NUMBER ! DNIS.
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11

DDE (DYNAMIC DATA EXCHANGE) SUPPORT IN
SMART CONTROL

Dynamic data exchange (DDE) is a form of communication (inter process) that uses shared memory to
exchange data between applications.

Applications can use DDE for one-time data transfers and for ongoing exchanges in which the applications
send updates to one another as new data becomes available.

" Client and Server Interaction

DDE always takes place between a client application (the ‘client’) and a server application (the ‘server’).
The client initiates the exchange by establishing a conversation with the server so that transactions can be
sent to the server. (A transaction is a request for data or services.)

The server responds to these transactions by providing data or services to the client. A server can have many
clients at the same time, and a client can request data from multiple servers.

Also, an application can be both a client and a server. A client terminates a conversation when it no longer
needs a server’s data or services. For example, a graphics application might contain a bar graph that
represents a corporation’s half -yearly profits, and the data for the bar graph might be contained in a
spreadsheet application.

To obtain the latest profit figures, the graphics application (client) establishes a conversation with the
spreadsheet application (server). The graphics application then sends a transaction to the spreadsheet
application, requesting the latest profit figures.

 11.1 Smart Control Application as DDE Client
Smart Control can act as a DDE client to start a conversation with Personal Information Manager (PIM)
applications such as Symantec ACT! 2.0, GoldMine for Windows, SuperOffice etc. These applications act
as DDE servers.

 You can Enable DDE in Smart Control by selecting Options/Set Environment->DDE….
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FIGURE 11-1

When DDE is enabled in Smart Control, then for any incoming call a command is sent to your selected PIM
application (which acts like a DDE server) to search for the caller’s contact record based on the incoming
callerID or DNIS (Dialled Number Identification Services).

You have the option to specify the search based on call type, such as Internal Call and/or External Call, as
well as on CallerID or DNIS. The dialogue box that appears when you select Set Environment →
DDE…from the Option menu is shown below.

FIGURE 11-2
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In the DDE Program combo (dropdown list) box the following PIM applications are supported:

* Symantec ACT! 2.0,
*  GoldMine for Windows,
*  SuperOffice4.0,
*  Maximizer for Windows.

For these applications you need only select the PIM application name, the application’s EXE file path and
the database file to be opened for finding the contact record. The DDE initialisation based on the Services
Name and Topic Name is handled by Smart Control.

 11.1.1 Smart Control as DDE Client to Symantec ACT! 2.0
If you have enabled DDE and selected Symantec ACT! 2.0 as your PIM, you need to enter the path for the
ACTWIN2.EXE file. Choose your ACT file (*.DBF) containing the contact records. (If you are not sure
about the path of the EXE file, run the file by pressing the TEST button.)

When you click on OK on the Select the DDE Server dialogue box, DDE is initialised with ACT! as the
DDE server.

FIGURE 11-3
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 11.1.2 Smart Control as DDE client to GOLDMINE
If you have enabled DDE and selected GOLDMINE as your PIM, you need to enter the path for the
GOLDMINE file, GM4.EXE. Choose your GOLDMINE CONTACT file containing the contact records.
(If you are not sure about the path of the EXE file, run the file by pressing the TEST button.)

When you click OK on the Select the DDE Server dialogue box the DDE Server Information dialogue box
appears. This requires you to enter a username and password for GOLDMINE.

FIGURE 11-4

Guidelines for using Symantec ACT!:
1.
 To view the caller’s record in ACT!, you must set your current screen in ACT! to “Contact
Screen One” (see help on contact screen in ACT! for further information). An example “Contact
Screen One” for ACT! is shown in Figure 11-3..

2.
 Even though the caller’s contact record is found, ACT! does not pop up. It is better to have
ACT! maximized in the background.

3.
 If you have entered a password for database access, you need to run ACT! prior to the
initialiation of  DDE using Smart Control.

4.
 Format of phone numbers in ACT!:
If your contact record’s number is nnnnnnn (same area), you need to have this in ACT! as nnn-
nnn-n for popup to occur.

If your contact record’s number is cc-aa-nnnnnnn (different country), you need to have this in
ACT! as cca-ann-nnnnn for popup to occur.

If your contact record’s number is nnnn (mostly internal) then you need to have this in ACT! as
nnn-n.
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Enter your username and password, if any. When entered correctly, DDE is initialised.

 11.1.3 Smart Control as DDE Client to SuperOffice
If you have enabled DDE and selected SuperOffice4.0 as your PIM, you need to enter the path for the
SUPEROFFICE file, SUPEROF4.EXE. (If you are not sure about the path of the file, run it by pressing the
TEST button.) Even if you have not logged on to SuperOffice it still shows the contact pop up.

Guidelines for using GOLDMINE:

If it is a local number nnnnnnn then GOLDMINE stores it in the format (aa)nnn-nnnn where aa
denotes area code. For numbers other then local area numbers, you need to enter them
continuously without any special character such as - or ( , etc., for contact popup.

For example:
 If your contact’s phone number is aa-nnnnnnn, where aa is the area code, you need to enter it as
aannnnnnn in GOLDMINE.

Note:
Make sure to enter the correct GOLDMINE EXE file as the username and password are passed
along with it. If you enter any other EXE file there is a chance of the program crashing.

Guidelines for using SuperOffice4.0:
1.
 If your contact’s local area is the same as yours, you need to enter only the number.

2.
 SuperOffice doesn’t show a popup for numbers having more than eight digits. If you have
entered the number in the form aannnnnnn, where aa indicates the area code, then you cannot
view the popup.

Note for users in Norway:
 Norwegian users must always enter the area code (aa) before the phone number.  For example,
if the number is nnnnnn then they need to enter it as aannnnnn.
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 11.1.4 Smart Control as DDE Client to Maximizer for Windows
If you have enabled DDE and selected Maximizer for Windows as your PIM, you need to enter the path of
the Maximizer EXE file, MAXWIN.EXE. (If you are not sure about the path of the file, run it by pressing
the TEST button.)
When you click OK on the Select the DDE Server dialogue box, DDE is initialised with Maximizer as the
DDE server.

 11.2 Note for All PIMs (Symantec ACT!, GoldMine, SuperOffice,
Maximizer)

If you get the following error when you select any of the above PIMs, it means that DDE has not been
initialised.

FIGURE 11-5

The solution is to run the EXE file for the application you have selected. Go to Options/Set Environment →
DDE…  and enter the path of the program file and database file correctly. Then click OK on the dialogue
box to reinitialise DDE.
Remember, if you simply click OK on the error message box (above), you cannot see a contact popup for
incoming calls as DDE is not initialised.

Guidelines for using Maximizer for Windows:
If you have entered a username and password to access the database in Maximizer, then Maximizer
must be running prior to initialisation of DDE.

Note: Maximizer only points to the contact’s record. The contact's record is not popped  up. It is
better to keep the Maximizer application maximized in the background.

Note: If you close Smart Control with DDE enabled, then when you start Smart Control again,
DDE is initialised automatically.
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 11.3 General DDE Support
Smart Control can work with other applications acting as DDE servers. Select the Other option in the DDE
Program combo box (Figure 11-2) if you want to select an application other than that already selected.

The following steps explain how to use this feature.

1. Select the Other option in the DDE Program combo (dropdown list) box on the Select the DDE Server
dialogue box.

2. A help dialogue box appears (shown below) giving instructions you should follow.

FIGURE 11-6

3. Run your selected DDE application (server) EXE file.

4. Open the file of contacts (if any) in your DDE application (server).

5. Enter your selected DDE application’s Services Name and Topic Name, and the command which
replaces SN@TN@CMD in the Command edit box. Replace the phone digits in the command with
“CLID”. Figure 11-7 shows how the dialogue box would appear when Microsoft Access is selected as
the other DDE application (server).
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FIGURE 11-7

Here MSACCESS@System@[OpenForm FORMNAME,,,FORMFIELD=“CLID”] is entered instead of
SN@TN@CMD.

Where,
   SN-is Services Name(for Access it is MSACCESS).
   TN- is Topic Name(for Access it is System).
   CMD- is command(for Access it is [OpenForm FORMNAME,,,FORMFIELD=“CLID”] ).

   FORMNAME-The name of the form in Access.
   FORMFIELD-The name of the field in the form that contains the phone digits.

In the example shown above:

MSACCESS@System@[OpenForm LOG,,,telNo=“CLID”]
   LOG is the form name and telNo is the field in this form containing the phone digits.

 Note: “CLID” should be entered instead of the phone digits in the DDE command.
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Click the Format button and enter the different phone number formats (based on the number of phone
digits) in the Phone Number Formats dialogue box.

FIGURE 11-8

The dialogue box shown above displays the default formats for the various sizes of phone numbers.

The formats you enter should match the formats in your selected DDE application (server). This is
necessary as different PIMs store the phone numbers in different formats depending upon the number of
digits in the phone number. For example, In Symantec ACT! 2.0 the number is stored in xxx-xxx-xxxxxx
format. The number 2004 is thus  stored as 200-4.

Smart Control needs to know in what format the phone digits are stored in the selected PIM depending upon
the number of digits. Smart Control formats the number according to the format entered above and sends it
to the PIM for a search.

Click OK on  the Select the DDE Server dialogue box. If the following error message box appears, check if
your selected DDE application is running.
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FIGURE 11-9

The error signifies that DDE is not initialised with your selected DDE application (server).

 11.4 Smart Control as DDE Server

Smart Control as DDE server supports only the “SmartControl” Services Name and “Telephony” Topic
Name. Any client PIM can place a call using Smart Control. The client application needs to send the
command as “MakeCall XYZ” after starting the conversation using “SmartControl” as the Services Name
and “Telephony” as the Topic Name.

For example

A user of SuperOffice PIM can place a call using Smart Control. The following command needs to be
entered in the “Prefix” field of the Dial dialogue box in SuperOffice:

   DDE;SmartControl;Telephony;MakeCall XYZ

where XYZ is the number that is to be dialled.
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11.5 Pop Up with Microsoft Outlook Contacts

# Call Notification Enhancement
Smart Control V3.1 offers it’s own contact database and pops up a relevant page depending on how you
set up call notification options. To pop up other personal information managers, you had to set up DDE.
Smart Control V3.12 supports Microsoft Outlook screen pop in the same way as its own database. To
use this feature you have to configure Options Menu / Call Notification / Database option.

# How Do You Configure Database Options?
If you set the Options Menu / Call Notification / General / Display Call Details options, the Smart
Control searches for some databases to get a call party’s record.
To make the Outlook Contact popped, mark the check box titled “Search Outlook Contacts”. Then Smart
Control will pop up a relevant page from a Outlook Contact Database if a match is made between the
call party’s phone number and the telephone field in the database record.

Figure 11-10
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# How Do You Configure Outlook Contacts Searching Properties?
If you want to configure the phone number mask or outlook contact folder, click on the Properties button
next to the Outlook check box.

Figure 11-11
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$ Contact Database:
You can choose the folder in which the record to be searched. It is set Contacts folder by default.
If you want to change, click on the Browse button. The following dialog box will appear.

Figure 11-12

The Contact Database Information dialog box will show all the folders of your Outlook program. You
can select only contacts folder or its sub folders.
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$$$$ Mask Formats:
You can convert the phone number for Outlook contacts searching by setting some masks.
Enter a new mask in the New Mask edit box and click on the Add button, then it will be appended in the
Available box. If you selected a mask in the Available box and click on the add button below the box,
the mask will be activated and appended to the Active box.
The Smart Control allows +, -, (,), 0~9, B(representing a blank), D(deletion), and X(a wild character) to
compose a mask.

Phone Number saved In the Outlook
Contacts

Mask

+82 (331) 218 7429 +XXB(XXX)BXXXBXXXX

+1 (972) 716-7011 (STA only) +XB(XXX)BXXX-XXXX

+1B(XXX)BXXX-XXXX

(972) 716-7011 (STA only) (XXX)BXXX-XXXX

+61 (9) 1234567 +XXB(X)BXXXXXX

(9) 1234567 DD(X)BXXXXXXX

203 (internal) XXX

If you want to deactivate a mask, select the mask in the Active box and click on the remove button above
the box. The selected mask will be moved into the Available box.
If you want to completely remove a mask, move the mask into the Available box first. Then, choose the
mask in the Available box and click on the remove button above the Available box.

Note:

1. The Smart Control generates a CallerID or a CalledID, that is a phone number, including country code and
area code except STA version. Be sure that country code and area code are included in the Outlook contact
records or make use of the deletion mask(‘D’) properly.
2. The Outlook program inserts some blanks into the phone number automatically. You should include those
blanks in the mask to search those records.
3. The Smart Control and Outlook both get your location information from the Telephony settings of your
Windows system.
4. Do not include leading ‘0’ in the area code if you have one.
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                                                                              12

LIMITATIONS

1. When the Selection View is hidden, you cannot switch between the services or the phone books.

2. Phone book name can be maximum of 10 characters and cannot have spaces in the name.

3. For network data connection, validity of the database file for the network database is verified only after
the connection is made.

4. Default phone books cannot be renamed. (In Icon view it appears as though names can be changed, i.e.
if you click on the title of the icons it allows you to edit the name. However, after editing, the old name
is retained.)

5. If there is a call at your station and you start Smart Control, you cannot make a call using Smart Control
or view the call in Smart Control’s Call View. You must always start Smart Control with no calls at your
station.

6. There is possible that Smart Control can not run if your system does not have Microsoft Access Driver
as ODBC Driver. If so, Install that driver and then run smart control again. (When you install Microsoft
Office Software – Office97, Office 2000 etc , that software does install Microsoft Access Driver into
your system.)

Microsoft Windows 95, 98 and Windows NT are registered trademarks of Microsoft.
Other brand or product names are trademarks or registered trademarks of their respective
holders.


